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1. Droits d'auteur

Avertissement

Les auteurs ne sont nullement responsables de dommages directs
ou indirects qui pourraient résulter de l'utilisation de CFF.

CFF est un logiciel libre de copie (selon le principe du "shareware").
Après une période d'un mois d'essai, si le logiciel vous donne
satisfaction, vous êtes invité à payer une contribution aux auteurs
(3000 BEF, 500 FF, 140 DM).  Sinon, vous devez désinstaller le
logiciel et tous ces fichiers annexes.  Après paiement de votre
contribution, vous serez enregistré comme détenteur officiel du
logiciel.  Ceci vous donne l'avantage de recevoir un manuel
d'utilisation complet, des fichiers de contour supplémentaires, des
programmes utilitaires et d'être tenu au courant de l'évolution du
logiciel.

Les fichiers MWDB*.ALL (Micro World Data Bank) ont été placés
dans le domaine publique par Fred Pospeschil et Antonio Riveria.  Ils
sont l'expression condensée du fichier original WDB-II produit par la
Central Intelligence Agency (CIA).

Les fichiers de contours émanant de la Communauté Européenne ne
peuvent être utilisés qu'avec CFF.  Il ne peuvent en aucun cas être
distribués ou vendus à des tiers.  Ces fichiers ont été créés à partir
du fichier NUTS3 qui émane de l'Office Statistique des Communautés
Européennes (Eurostat, Luxembourg).  Ces fichiers sont les suivants:

ACORES1.CFF BELG1.CFF CH1.CFF
ALBANI1.CFF BELG2.CFF CHANNEL.CFF
ALGERIE1.CFF BELG3.CFF CORSE1.CFF
ANDORRA1.CFF BELG4.CFF DENMARK1.CFF
AUSTRIA1.CFF BULGARI1.CFF DENMARK3.CFF
BALEAR1.CFF CANARI1.CFF DEUTSCH1.CFF
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DEUTSCH2.CFF ICELAND1.CFF PORTUGA3.CFF
DEUTSCH4.CFF ITALIA1.CFF ROMANIA1.CFF
EIRE1.CFF ITALIA4.CFF SLOVAK1.CFF
EIRE3.CFF LIECHT.CFF SWEDEN1.CFF
ESPAGN1.CFF LUXEMB1.CFF TCHEQU1.CFF
ESPAGN3.CFF MADEIR1.CFF TUNIS1.CFF
ESPMARO.CFF MALTA1.CFF TURKWEST.CFF
EXYOUGO1.CFF MAROC1.CFF TURKEY.CFF
FINLAND1.CFF NEDERLA1.CFF UK1.CFF
FRANCE1.CFF NEDERLA3.CFF UK3.CFF
FRANCE3.CFF NORWAY1.CFF
HELLAS1.CFF NUTSREST.CFF
HELLAS3.CFF POLAND1.CFF
HUNGARY1.CFF PORTUGA1.CFF
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2. Matériel requis

Matériel et système d'exploitation requis

● Ordinateur de type PC avec processeur 80x86

● Carte VGA ou supérieure (SVGA)

● MS-DOS version 3.1 ou supérieure

● Une souris

Matériel conseillé:

● écran VGA couleur

● processeur 80486DX ou supérieur

● Coprocesseur mathématique très utile

Le tableau I reprend les temps d'affichage d'un gros fichier de contour
pour différentes configurations matérielles et logicielles.

Tableau I. Comparaison des performances d'affichage pour différentes
configurations matérielles et logicielles.  Temps d'affichage du fichier
MFMWDB2.ALL en projection de GALL.

Type de configuration Temps d'affichage

PC 80486 100Mhz 00'56"

PC 80486 66 Mhz avec Stacker 01'17"
4.0

PC 80386 20 Mhz avec 05'42"
coprocesseur mathématique

80387 et Stacker 4.0

PC 80386 20 Mhz avec Stacker 17'38"
4.0
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3. Installation et configuration

Pour une installation standard, lancez, à partir du lecteur de
disquette, le programme INSTALL. 

Les fichiers suivants sont nécessaires au bon fonctionnement de
CFF.  Ils sont livrés sous forme compressée auto-décompactable.

CFF.EXE Programme CFF
CFF.INI Fichier de sauvegarde des

paramètres
HELV*.GFN Polices de caractères écran
PROLCFF.PS Prologue PostScript
CFFMENU.* Fichiers menus.  L'extension précise

la langue utilisée (FR=Français,
EN=Anglais, ES=Espagnol,
NL=Néerlandais, DE=Allemand,
IT=Italien)

CFFMESS.* Fichiers des messages.  L'extension
précise la langue utilisée.

*.CFF Fichiers de contour (format binaire)
*.ALL Fichiers de contour (format binaire,

structure Micro World Data Bank)
*.DSC Fichier de description des cartes

sauvegardées
*.PS Fichier d'impression des cartes

sauvegardées
*.PCX Images écran des cartes

sauvegardées
CFFCONV.EXE Utilitaire de conversion d'un fichier

PRN en fichier CFF
CFFCONV.* Fichiers des messages pour

CFFCONV.  L'extension précise la
langue

CFFGRI.EXE Générateur de grilles UTM, degrés
et grades
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CFFGRI.* Fichiers des messages pour
CFFGRI. L'extension précise la
langue

CFFTABL.EXE Programme de numérisation de
cartes sur tablette à digitaliser

CFFTABL.* Fichiers des messages pour
CFFTABL. L'extension précise la
langue

RESUDEG.EXE Utilitaire destiné à remplacer
RESURAD.EXE dans le logiciel
Microbanque Faune-Flore (RASMONT

& AL, 1993).
CARTEZ.BAT Fichier de remplacement pour

Microbanque Faune-Flore (RASMONT

& AL, 1993).

CFF.EXE peut se trouver dans n'importe quel répertoire pour autant
que le chemin d'accès soit spécifié (tapez PATH pour contrôler ou
PATH=chemin d'accès  pour mettre à jour).

Lors de son lancement, CFF recherche le fichier d'initialisation
CFF.INI.  Par défaut, CFF cherche d'abord ce fichier dans le
répertoire C:\BANQUE.  Si le fichier n'est pas trouvé, il est recherché
dans le répertoire racine de tous les disques durs installés sur votre
ordinateur.  S'il n'est toujours pas trouvé, c'est dans le répertoire
courant qu'il est recherché.  Enfin, si CFF.INI n'a pu être trouvé, CFF
choisi des valeurs par défaut et demande le nom du répertoire de
référence.  Ce répertoire contient les fichiers qui sont soulignés dans
la liste ci-dessus.  Il est indispensable de préciser le nom de ce
répertoire.  Sans cela, CFF est incapable de fonctionner.

Le format du fichier CFF.INI est expliqué au chapitre 8.

Si vous êtes un utilisateur de Microbanque Faune-Flore, le fichier
RESUDEG.EXE doit être copié dans le répertoire
C:\BANQUE\MICROBAN.
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Sur les écrans monochromes, il faut lancer la commande DOS
suivante avant CFF:  MODE CO80.  Sans cela, le programme ne
fonctionne pas.

Exemple d'installation

Répertoire (structure conseillée) fichiers

C:\BANQUE CFF.INI
C:\BANQUE\CARTOG *.CFF, *.ALL, *.PS, *.DSC,

*.PCX, CFFMENU.*,
CFFMESS.*, *.CFG

C:\BANQUE\MICROBAN *.EXE

Ceci correspond à l'installation par défaut effectuée par le programme
Install.

Langue de travail

CFF est un programme multilingue.  La langue par défaut est
l'anglais.  Si vous désirez utiliser une autre langue de travail, cliquez
sur le menu "Options " et ensuite sur "Language ", choisissez ensuite
la langue appropriée.  Les menus et les messages sont désormais
affichés dans la langue choisie.  Dans cette version, 3 langues sont
disponibles: français, anglais et espagnol.
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4. Possibilités offertes par CFF

CFF est un logiciel de cartographie à l'usage des biogéographes.  Il
est destiné à l'élaboration de cartes de répartition de taxons animaux
ou végétaux.

Un grand nombre de fichiers de contours peut être surimposé.

Les distributions peuvent être affichées selon plusieurs modes:

● simple présence (1 symbole par taxon, maximum 5 taxons
par carte);

● présence selon 1, 2 ou 3 périodes (1, 2 ou 3 symboles
différents pour le même taxon);

● symboles dont la taille est fonction du nombre de
spécimens ou de données.

9 projections sont offertes: Lambert conique, Stéréographique,
Mercator, Platte-Carrée, Equirectangulaire de Miller, BSAM (Bolshoi
Sovietsky Atlas Mira), Gall, Cylindrique généralisée et Sinusoïdale.

Le méridien central est soit calculé de manière automatique, soit
calculé de manière à ce qu'il corresponde au centre du fuseau UTM
le plus proche (cela permet d'afficher correctement le quadrillage
UTM), soit laissé au choix de l'utilisateur.

Les cartes peuvent être imprimées sur une imprimante PostScript ou
vers des fichiers EPS (Encapsulated PostScript).  Ces derniers
peuvent être inclus dans un logiciel de traitement de texte ou de mise
en page.  Des copies d'écrans peuvent être envoyées vers des
imprimantes non-PostScript.  Il est également possible de sauver
l'écran vers un fichier de type PCX.

Il est possible d'éditer la légende de la carte, d'ajouter librement du
texte et de tracer des polygones sur la carte.
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L'utilisateur maîtrise entièrement les paramètres de couleur,
d'épaisseur et de style des lignes et des symboles.
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5. Guide d'utilisation

5.1. Confection des cartes

Avant de commencer, il faut bien comprendre les deux modes de
fonctionnement de CFF.

Deux possibilités sont offertes pour la production de cartes:

1. Le mode vectoriel

2. Le mode mixte

Le mode vectoriel

La carte est affichée à partir du (des) fichier(s) de fonds de cartes qui
contiennent les coordonnées géographiques des contours.  Avec ce
type de carte, on peut zoomer (en avant ou en arrière) à volonté.  A
chaque affichage de la carte, tous les fichiers de contours concernés
sont lus.

Le mode mixte

La carte est affichée à partir d'une image conservée sur le disque dur
sous forme de fichier PCX.  L'affichage est très rapide mais il est
impossible de zoomer ou de changer les paramètres de la projection
avec ce type de carte.  Un fichier vectoriel PostScript correspondant
exactement à la mise en page de la carte écran est sauvegardé.
C'est ce fichier vectoriel qui sert à l'élaboration des fichiers
d'impression.  Il n'y a donc aucune perte de résolution  lors de
l'emploi du mode mixte.
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Choix d'un mode d'affichage

Le mode vectoriel est le plus puissant des deux grâce à ses
possibilités de zoom.  Cependant, la lenteur relative de l'affichage
devient un handicap sérieux quand le fond de carte est compliqué ou
quand on dispose d'une machine à processeur lent ou sans
coprocesseur mathématique.  Dans ce cas, il est préférable de mettre
au point son fond de carte une fois pour toutes en mode vectoriel et
de le sauvegarder ensuite pour l'utiliser ultérieurement en mode mixte
(option "Sauver le fond actuel " du menu "Fichier ").

Création d'une nouvelle carte

Pour créer une nouvelle carte, sélectionnez "Nouvelle carte " dans le
menu "Fichier ".  CFF affiche alors la liste des fichiers de contours
disponibles dans le répertoire de référence (le nom de ce répertoire
est précisé dans le fichier CFF.INI).  Dans la liste, pointez les fichiers
que vous voulez voir apparaître sur la carte.  Les fichiers
sélectionnés sont précédés du symbole "V".  Pour mettre fin à la
sélection des fichiers, choisissez "-----Ok-----" dans le haut de la
fenêtre.

Le programme vous laisse alors le choix entre deux méthodes de
fenêtrage: automatique ou manuel.  Le fenêtrage automatique
englobe automatiquement tous les fichiers sélectionnés
précédemment (à l'exception des fichiers de grille géographique).
Avec le fenêtrage manuel, vous devez préciser les latitudes et
longitudes minimales et maximales de la fenêtre.

CFF affiche ensuite une fenêtre et y dessine la carte.  Le
pourcentage de fichier traité défile dans le bas de l'écran.  Vous
pouvez interrompre l'affichage du fichier en cours en appuyant sur la
touche [Esc ] ou en cliquant sur le bouton droit de la souris.
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Quand le pointeur de la souris se trouve sur la carte, CFF affiche les
coordonnées géographiques de celui-ci.

Ajout de contours

Pour ajouter un contour supplémentaire (par exemple une grille
UTM), choisissez "Ajouter un contour " dans le menu "Fichier ".
Pointez le fichier voulu dans la liste.  CFF ajoute automatiquement le
nouveau contour à la carte.

Suppression de contour

Pour supprimer un contour, choisissez "Supprimer un contour "
dans le menu "Fichier ".  Sélectionnez le fichier à supprimer dans la
liste.  Validez votre choix en appuyant sur [Enter ] ou en cliquant deux
fois sur le nom du fichier.  Recommencez l'opération autant de fois
que voulu.  Quitter la fenêtre en appuyant sur [Esc ] ou en cliquant sur
le bouton droit de la souris.  Vous avez ensuite la possibilité de
redessiner la carte

Sélectionnez ensuite "Redessine carte " du menu "Affichage " ou
appuyez sur "F5" pour mettre à jour la carte à l'écran.

Zoom

Le zoom n'est disponible qu'en mode vectoriel (voir ci-dessus).

On peut zoomer avec la souris de la façon suivante:

● sélectionnez "Zoom + " dans le menu "Affichage ". Le
curseur de la souris est modifié et son déplacement est
strictement limité à l'espace occupé par la carte.

● Cliquez avec le bouton de gauche sur le coin supérieur
gauche de la nouvelle fenêtre et maintenez ce bouton
enfoncé.
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● Faites glisser le curseur jusqu'au coin inférieur droit de la
partie à zoomer et lâcher le bouton.

● CFF demande alors confirmation avant d'afficher le zoom.

On peut zoomer autant de fois que l'on veut.  Néanmoins, pour les
grandes échelles, le programme devient relativement imprécis et il
adopte alors un comportement imprévisible.  Dans la version actuelle,
on ne peut pas afficher une aire inférieure à 1 km2.

A chaque zoom, les paramètres de projection sont recalculés.  Par
conséquent, le cadrage original est modifié.  Pour un travail précis, il
est recommandé d'ajuster le zoom très progressivement, par petites
touches successives.

La commande "Zoom - " du menu "Affichage " vous permet d'afficher
le zoom précédent.  S'il n'y a pas de zoom précédent (en fait quand la
carte initiale est affichée), CFF propose un zoom manuel.  Entrez les
nouvelles coordonnées du cadre.

Options d'affichage

Les options d'affichage permettent de contrôler la couleur, le style et
la visibilité des différents types de contours.

Les fichiers de contour *.CFF peuvent comporter 5 types différents de
contour:

● frontières

● rivières

● canaux

● lacs

● grilles géographiques

Chacun de ces types de contour peut avoir 5 niveaux d'importance.
Les niveaux vont de 1 à 5.  Le niveau le plus important est le 1.
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Ainsi, par exemple, les frontières de la France sont au niveau 1 alors
que les contours des départements sont au niveau 3.

Les options d'affichage permettent de contrôler l'apparence de tous
les contours selon leurs niveaux respectifs.

Pour modifier la couleur, choisissez l'option "Couleurs lignes " du
menu "Options ".  Pour chacun des traits, choisissez la couleur
désirée.  Si vous n'avez pas envie de voir apparaître un type de
trait, sélectionnez "Aucune" comme couleur de trait.

Pour modifier le style, choisissez "Style lignes " dans le menu
"Options ".

La couleur du fond de carte peut être modifiée via le choix de
"Couleur du fond de carte " dans le menu "Option ".  Une fois la
nouvelle couleur choisie, CFF brosse toute la surface de la carte et
remplace l'ancienne couleur de fond de carte par la nouvelle.

En sélectionnant "Marge " dans le menu "Affichage ", vous pouvez
maitriser le positionnement du bord gauche de la carte.  Cette option
est surtout utile lors des impressions d'écran.  Une fois cette option
choisie, CFF matérialise la marge par une ligne verticale qui apparaît
du côté gauche de l'écran.  Positionnez la nouvelle marge à l'aide de
la souris et cliquez sur le bouton de gauche pour confirmer le choix.

Sauvegarde et rappel des options d'affichage

La commande "Sauver les réglages " du menu "Fichier " vous
permet de sauver toutes les options d'affichage dans un fichier.  Ces
options peuvent être rappelées ultérieurement au moyen de la
commande "Charger des réglages ".  Ces fichiers portent l'extension
"*.CFG" et sont sauvegardés dans le répertoire de référence.
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Les options sauvées sont: couleur du fond de carte (1), couleurs des
contours (24), styles des contours (24), épaisseurs des contours (24),
grisés des contours (24), symboles (5), grisés des symboles (5),
épaisseur des symboles (1), couleur des symboles PostScript (5),
couleurs des lignes PostScript (24), couleur écran des symboles (5)
et types de symboles PostScript (1).

Sauvegarde d'un fond de carte

Une fois la carte mise au point, il est possible de la sauvegarder (voir
le mode mixte ci-dessus).  Avant de sauvegarder le fond de carte,
vérifiez toutes les options PostScript liées aux traits  (voir ci-
dessous).

La commande "Sauver le fond actuel " du menu "Fichier " permet de
faire la sauvegarde du fond de carte.  CFF vous demande de donner
un nom de fichier de sauvegarde.  CFF demande également le nom
du fichier PostScript associé.  Le mieux est de prendre, par défaut, le
même nom que le fichier précédent.

La procédure génère trois fichiers qui seront tous contenus dans le
répertoire de référence des fichiers de contours (par défaut
C:\BANQUE\CARTOG).  Ces 3 fichiers sont:

1. le fichier portant l'extension DSC.  Ce fichier ASCII contient
les paramètres de projection et de mise en page de la
carte.

2. le fichier portant l'extension PCX.  Ce fichier binaire
contient l'image "bitmap" de la carte affichée à l'écran.

3. le fichier portant l'extension PS.  Ce fichier ASCII est le
fichier PostScript correspondant au tracé de la carte.  Il
sera utilisé à chaque impression ultérieure de celle-ci.
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Récupération d'un fond de carte

La commande "Charger un fond " du menu "Fichier " permet de
récupérer un fond de carte préalablement sauvegardé au moyen de
la commande "Sauver le fond actuel ".

CFF affiche une fenêtre proposant l'ensemble des fichiers *.DSC du
répertoire de référence.  Choisissez le fichier voulu soit en tapant
[Enter ] soit en cliquant 2 fois sur le nom du fichier.

CFF affiche alors l'image de la carte sauvegardée.  Il vous est alors
possible de travailler comme sur une autre carte mais avec les
restrictions suivantes:

● impossible de zoomer en avant ou en arrière;

● impossible d'enlever des traits faisant partie de la carte
sauvegardée;

● impossible de modifier l'apparence des traits sauvegardés;

● impossible de modifier la projection.

5.2. Choix de la projection

La projection géographique utilisée détermine la façon dont les
coordonnées sphériques (latitude, longitude) sont transformées en
coordonnées planes (x, y) sur l'écran ou sur la feuille de papier.

Il est en fait impossible de transformer des coordonnées sphériques
en coordonnées planes sans provoquer des altérations dans la
représentation des surfaces, des angles ou des distances.  Selon la
projection choisie, les altérations seront plus ou moins importantes et
frapperons les distances, les surfaces, les angles ou encore les 3
paramètres à la fois.
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On classe traditionnellement les projections cartographiques en 4
familles selon le type d'altération provoquée:

● les projections conformes : conservent les angles mais ne
conservent ni les surfaces ni les distances (projections
Lambert, stéréographique, UTM, Mercator, Miller, BSAM,
Gall);

● les projections équivalentes : conservent les surfaces
mais pas les formes (projection de Bonne , non
implémentée dans cette version);

● les projections équidistantes : conservent les distances le
long de certaines lignes privilégiées (projection Plate-
Carrée, sinusoïdale);

● les projections aphilactiques : ne conservent aucun des
éléments repris ci-dessus.

Dans CFF, les projections sont classées en coniques, cylindriques ou
pseudo-cylindriques.  Ces distinctions sont faites selon la nature du
plan de projection utilisé.

Les projections cylindriques conviennent pour les mappemondes ou
les cartes des régions de latitudes faibles à moyennes (environ de -
75 à +75˚).  Certaines des projections cylindriques provoquent des
altérations de surface très importantes dans les régions polaires (par
exemple la projection de Mercator).  Elles doivent être restreintes à la
cartographie des région intertropicales.

Les projections Lambert conviennent très bien pour les régions de
latitude moyenne comme l'Europe.  Elles permettent d'obtenir une
très bonne représentation du carroyage UTM.  Dans la présente
version de CFF, elles ne peuvent pas être utilisées pour l'hémisphère
sud.

La projection sétréographique polaire est bien adaptée pour les
régions de très hautes latitudes nord ou sud.

Les projections sinusoïdale et Platte-Carrée sont en général assez
inesthétiques mais elles sont très rapides d'affichage.
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En guise de résumé, nous dirons qu'il est préférable de choisir:

● une projection Lambert pour les cartes des régions de
latitude moyenne (de 25 à 75˚ environ) et d'échelle
relativement grande (surfaces de l'ordre du continent ou
inférieure), surtout si on surimpose un carroyage UTM à la
carte;

● une projection cylindrique pour les mappemondes, avec
une préférence pour celles qui atténuent les altérations
dans les régions polaires (Gall ou BSAM par exemple).

5.3. Affichage de distributions sur la carte

Une fois le fond de carte terminé, il est possible d'ajouter des
symboles qui vont représenter la distribution de un ou de plusieurs
taxons.

Pour ajouter une distribution, choisissez la commande
"Ajouter une distribution " du menu "Fichier ".  CFF affiche une
fenêtre avec la liste des fichiers du répertoire courant et qui ont
l'extension .DEG ou .RAD.  Ces fichiers doivent rigoureusement
respecter le format prescrit (voir chapitre 8 pour l'explication du
format).  Ces fichiers sont générés par Microbanque Faune-Flore à
travers l'ancien module RESURAD et le nouveau module RESUDEG
(livré avec le présent logiciel).  RESURAD et RESUDEG produisent
un fichier (RESUME.RAD ou RESUME.DEG) contenant les
coordonnées des points de la distribution.  Les coordonnées
contenues dans le fichier .RAD sont exprimées en 1/10000 de
radians alors que dans le fichier .DEG, elles sont en degrés décimaux
(5 décimales, résolution métrique).  Les fichiers .DEG sont nettement
plus précis que les .RAD; il faut donc éviter d'utiliser les fichiers .RAD
pour les carte à grande échelle (fort grossissement).



CFF - Manuel d'utilisation - 18

CFF donne ensuite le choix entre 4 modes d'affichage de la
distribution:

1. par période: on tient compte des périodes qui sont
indiquées dans l'entête du fichier de distribution.  La
distribution est représentée avec autant de symboles qu'il
n'y a de périodes, avec un maximum de 3 périodes.  Les
symboles choisis sont le n˚3 pour la période la plus
ancienne, le n˚2 pour la période intermédiaire et le n˚1 pour
la période la plus récente.  Avec ce mode, on ne peut
afficher qu'une seule distribution à la fois.

2. par symboles fixes: la distribution est figurée par un seul
type de symbole ou directement par le nombre de
spécimens, quelle que soit la période.  On peut cumuler
jusqu'à 5 distributions sur une même carte.

3. par symboles proportionnels au nombre de spécimens: la
distribution est affichée avec des symboles dont la taille est
directement proportionnelle au nombre de spécimens
enregistrés pour chaque coordonnée.  Le découpage en
classes est laissé au choix de l'utilisateur.  Dans le but
d'aider au découpage en classes, CFF affiche les valeurs
maximales détectées dans le fichier.

4. par symboles proportionnels au nombre de données: le
principe est le même qu'au point 3 mais c'est le nombre de
données qui est pris en considération et pas le nombre de
spécimens.

Après avoir choisi le type d'affichage, la distribution est affichée sur la
carte.  Pour modifier les symboles utilisés, choisissez la commande
"Symboles " puis "Types de symboles " dans le menu "Options ".
"Couleurs des symboles " vous permet de modifier la couleurs des
symboles affichés à l'écran.

Pour supprimer la ou les distribution(s) affichée(s) sans perdre le
fond de carte, choisissez la commande "Supprimer distributions "
du menu "Fichier ".
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5.4. Statistiques sur les distributions affichées

Quand une ou plusieurs distributions sont affichées, l'option
"Statistiques " du menu "Affiche " permet de délimiter un cadre avec
la souris et d'obtenir les informations disponibles pour ce cadre
géographique.  Selon le type d'affichage retenu, CFF donne le
nombre de spécimens et de données pour chaque période ou pour
chaque taxon.  Vous pouvez sauver le résultat dans un fichier ASCII
et le récupérer ensuite dans un traitement de texte.

5.5. Impression

Le menu "Impression " permet d'imprimer directement sur
imprimante ou indirectement sur un fichier PostScript.

La commande "Imprimante... " du menu "Impression " donne le choix
entre 4 types d'imprimantes.  Les résultats obtenus sont très
différents d'une imprimante à l'autre: pour les imprimantes
"matricielle ", "Deskjet " et "LaserJet ", l'impression se résume à une
simple copie d'écran.  Le résultat obtenu est assez décevant mais il
peut servir utilement comme brouillon de carte obtenu rapidement.
Par contre, le choix de l'imprimante PostScript donne des résultats
excellents à condition bien sûr de disposer d'une imprimante de ce
type.

Les commandes "Fichier EPS  noir et blanc " et
"Fichier EPS couleur " permettent de générer des fichiers au format
"Encapsulated PostScript".  Ces fichiers peuvent être intégrés dans
des applications comme Word ou PageMaker et y être mis en page
librement avant l'impression sur une imprimante PostScript.  Le plus
souvent, ces fichiers sont imprimés sur n'importe quelle imprimante à
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l'aide d'un logiciel spécial d'interprétation du PostScript.  Certains de
ces logiciels relèvent du domaine public*.

Il est possible, en PostScript, de maîtriser l'apparence de tous les
paramètres de la carte et de la distribution au moyen du menu
"Options ".  Dans ce menu, les changements effectués sur les styles
de lignes et les symboles seront répercutés sur les impressions
PostScript.  La commande "PostScript... " de ce menu permet de
maîtriser les autres paramètres: épaisseur des lignes, grisés des
lignes, couleur des lignes, grisés des symboles, épaisseur des lignes
entourant les symboles, couleur des symboles.  Ces paramètres ne
sont pas maitrisables sur les cartes chargées avec la commande
"Charger un fond " du menu "Fichier ".

Le menu "Impression " permet également de sauvegarder l'écran
sous forme de fichier PCX.  Vous pouvez récupérer ce fichier dans
un logiciel de dessin "bitmap" comme PaintBrush pour
éventuellement le retoucher.

5.6. Autres options

Les autres commandes du menu "Options " sont:

● "Méridien central ": pour modifier le méridien qui sert de
centre de référence à la carte.  En choisissant
"Automatiquement centré sur le fuseau UTM le plus
proche", le quadrillage UTM central sera toujours droit
(pour autant que la projection choisie soit celle de
Lambert).

● "Projection ": pour choisir le type de projection à appliquer.
La projection la plus esthétique, sous nos latitudes, est
celle de Lambert.

 

* GhostScript, disponible sur le réseau internet (serveur FTP) à l'adresse
ftp.cs.wisc.edu, est un bon interpréteur de ce type.  GoScript (LaserGo Inc., 9369
Carroll Park Drive Suite A, San Diego, CA 92121 USA, tel (619) 450 4600, Fax (619)
450 9334), vendu environ pour 80$, donne des résultats parfaits.
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● "Unités ": pour modifier les unités accompagnant les
distributions.  Par défaut, ces unités sont "spécimens" et
"données".

5.7. Ajout et modification d'éléments sur la carte

Le menu "Edition " permet d'ajouter ou de modifier certains éléments
de la carte.

"Titre de la carte " permet d'ajouter un texte quelconque dans le coin
inférieur droit de la carte, sous le cadre.

"Titres distributions " permet de modifier les titres des distributions.
Ces titres sont, par défaut, les noms des taxons concernés (voir la
structure des fichiers DEG et RAD au chapitre 8).

"Légendes distributions " permet de modifier le texte qui
accompagne les titres de distributions.  Par défaut, ce texte est
composé du nombre d'individus et de données du taxon concerné.

"Ajouter du texte " permet d'ajouter du texte librement à n'importe
quel endroit de la carte.  CFF demande d'abord le texte.  Ensuite,
vous êtes invité à choisir la taille du texte en points.  CFF dessine
alors, dans le coin supérieur gauche de la carte, un rectangle qui
représente l'espace qu'occupera le texte.  Déplacez ce rectangle au
moyen de la souris et choisissez sa position.  Validez la nouvelle
posisition en cliquant sur le bouton de gauche.  Lors de l'impression
PostScript, il arrive que le texte n'occupe pas exactement la même
place qu'à l'écran.  Cela est dû au fait que la police écran n'est pas la
même que la police PostScript.  Le point de référence commun aux
deux systèmes est le coin supérieur gauche du cadre englobant le
texte.

"Enlever du texte " permet de retirer du texte préalablement placé au
moyen de la commande précédente.  CFF affiche la liste des textes
présents sur la carte.  Choisissez le(s) texte(s) à supprimer en
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cliquant deux fois dessus avec le bouton gauche de la souris ou avec
la touche [Enter ].  Sortez de la fenêtre en cliquant sur le bouton droit
de la souris ou en tapant sur la touche [Esc ].  Pour mettre à jour la
carte, tapez sur la touche "F5" ou choisissez la commande
"Réaffiche carte " du menu "Affichage ".

"Echelle... " permet, lors de sa première utilisation, d'ajouter une
échelle à la carte.  CFF vous demande la distance à représenter par
une ligne horizontale.  Pour vous aider, CFF indique la largeur
maximale de la carte (en kilomètres).  Entrez une valeur inférieure à
ce maximum.  CFF vous propose alors de placer la barre horizontale
sur la carte.  Déplacez cette barre à l'aide de la souris et cliquez pour
fixer l'emplacement.  Pour déplacer ou supprimer l'échelle, choisissez
à nouveau "Echelle... " dans le menu "Edition ".

"Ajouter un polygone ", dans le menu "Edition " sert à tracer des
lignes droites sur la carte.  Cliquez d'abord sur un point de départ.
Ensuite, déplacez la souris: un segment de droite s'affiche et se
déplace en même temps que la souris.  Quand ce segment est bien
positionné, cliquez à gauche pour le fixer.  Tant que vous ne cliquez
pas sur le bouton droit, CFF reste en mode tracé de polygone.

La commande "Maille " du menu "Affichage " sert à superposer une
maille sur la carte en cours.  L'écart entre deux points de la maille est
laissé au choix de l'utilisateur.  La maille n'est pas "attachée" à la
carte: elle disparaît en cas de réaffichage ou de zoom.  Lors de
l'impression PostScript, CFF demande s'il faut ou non imprimer une
maille sur la carte (effacez le 1 proposé par défaut pour éviter
l'impression d'une maille).
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6. Exemples pratiques
d'utilisation

6.1. Faire une carte de France

Le but est d'obtenir une carte de France avec uniquement ses limites
nationales.

(c) CFF 1.0 - 1995

Voici les étapes à suivre dans l'élaboration de cette carte:

1. Dans CFF, choisissez d'abord les options d'affichage au
moyen du menu "Options".
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- Sélectionnez "Couleur fond de carte".  Cliquez deux
fois sur "Gris" avec le bouton gauche de la souris.

- Dans le même menu, sélectionnez "Couleur lignes".
Cliquez 2 fois sur "Frontière 1" et choisissez "Jaune"
comme couleur.  Cliquez deux fois sur "---Ok---" pour
quitter la fenêtre.

- Dans le même menu, sélectionnez "Styles lignes".
Pour "Frontière 1", choisissez "Plein".  Cliquez deux fois
sur "---Ok---" pour quitter la fenêtre.

2. Dans le menu "Options", choisissez "Projection" et
sélectionnez "Lambert conique" puis "Calcul automatique
des parallèles de référence"

3. Dans le menu "Options", choisissez "Méridien central" et
sélectionnez "Automatiquement centré sur le fuseau UTM
le plus proche"

4. Dans le menu "Fichier", choisissez "Nouvelle Carte".  Une
fenêtre affiche la liste des fichiers de contour contenus
dans le répertoire de référence.  Cliquez 2 fois sur
"FRANCE1.CFF".  Le signe "V" doit apparaître à gauche de
ce fichier.  Cliquez ensuite 2 fois sur "---Ok---" (dans le haut
de la fenêtre).

5. Vous avez maintenant le choix du cadrage de la carte.
Choisissez "Fenêtrage automatique"

6. La carte s'affiche.

7. Avant d'imprimer la carte en PostScript, il faut régler les
options d'impression.  Dans le menu "Options", choisissez
"PostScript..." puis "Epaisseur des lignes".  Pour "Frontière
1", choisissez "Normal".  Toujours dans les options
PostScript, choisissez "Grisé des lignes"; choisissez "Noir"
pour "Frontière 1" puis "---Ok---" pour valider.

8. Vous pouvez maintenant imprimer la carte vers une
imprimante PostScript ou vers un fichier EPS.  Vous
pouvez aussi sauver le fond de carte pour le conserver de
façon définitive (voir exemple 6.3).



CFF - Manuel d'utilisation - 25

6.2. Faire une carte de la Belgique avec les limites
des 3 régions et le quadrillage UTM de 100 km de
côtés

(c) CFF 1.0 - 1995

Voici les étapes à suivre dans l'élaboration de cette carte:

1. Dans CFF, choisissez d'abord les options d'affichage au
moyen du menu "Options".

- Sélectionnez "Couleur fond de carte".  Cliquez deux
fois sur "Gris" avec le bouton gauche de la souris.

- Dans le même menu, sélectionnez "Couleur lignes".
Cliquez 2 fois sur "Frontière 1" et choisissez "Jaune"
comme couleur.  Choisissez "Blanc" pour "Frontière 2" et
"Noir" pour "Grille 1".  Cliquez deux fois sur "---Ok---"
pour quitter la fenêtre.

- Dans le même menu, sélectionnez "Styles lignes".
Pour "Frontière 1", choisissez "Plein" de même que pour
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"Grille 1".  Pour "Frontière 2", choisissez "Pointillé".
Cliquez deux fois sur "---Ok---" pour quitter la fenêtre.

2. Dans le menu "Options", choisissez "Projection" et
sélectionnez "Lambert conique".

3. Dans le menu "Options", choisissez "Méridien central" et
sélectionnez "Automatiquement centré sur le fuseau UTM
le plus proche"

4. Dans le menu "Fichier", choisissez "Nouvelle Carte".  Une
fenêtre affiche la liste des fichiers de contour contenus
dans le répertoire de référence.  Cliquez 2 fois sur
"BELG2.CFF".  Le signe "V" doit apparaître à gauche de
"BELG2.CFF".  Dans la même fenêtre, choisissez
"BELG1.CFF" et "UTM100.CFF" de la même façon.
Cliquez ensuite 2 fois sur "---Ok---" (dans le haut de la
fenêtre).

5. Vous avez maintenant le choix du cadrage de la carte.
Choisissez "Fenêtrage automatique"

6. La carte s'affiche.

7. Avant d'imprimer la carte en PostScript, il faut régler les
options d'impression.  Dans le menu "Options", choisissez
"PostScript..." puis "Epaisseur des lignes".  Pour "Frontière
1", choisissez "Normal"; puis "Fin" pour "Frontière 2" et
"Très fin" pour "Grille 1".  Toujours dans les options
PostScript, choisissez "Grisé des lignes"; choisissez "Noir"
pour les 3 types de contour puis "---Ok---" pour valider.

8. Vous pouvez maintenant imprimer la carte vers une
imprimante PostScript ou vers un fichier EPS.  Vous
pouvez aussi sauver le fond de carte pour le conserver de
façon définitive (voir exemple 2).
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6.3. Faire un fond de carte réutilisable du midi de la
France avec les contours des pays limitrophes

(c) CFF 1.0 - 1995

Voici les étapes à suivre dans l'élaboration de cette carte:

1. Dans CFF, choisissez d'abord les options d'affichage au
moyen du menu "Options".

- Sélectionnez "Couleur fond de carte".  Cliquez deux
fois sur "Gris" avec le bouton gauche de la souris.

- Dans le même menu, sélectionnez "Couleur lignes".
Cliquez 2 fois sur "Frontière 1" et choisissez "Jaune"
comme couleur.  Choisissez "Blanc" pour "Frontière 3".
Cliquez deux fois sur "---Ok---" pour quitter la fenêtre.

- Dans le même menu, sélectionnez "Styles lignes".
Pour "Frontière 1", choisissez "Plein" de même que pour
"Frontière 3" et "Grille 1".  Cliquez deux fois sur "---Ok---"
pour quitter la fenêtre.
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2. Dans le menu "Options", choisissez "Projection" et
sélectionnez "Lambert conique".

3. Dans le menu "Options", choisissez "Méridien central" et
sélectionnez "Automatiquement centré sur le fuseau UTM
le plus proche"

4. Dans le menu "Fichier", choisissez "Nouvelle Carte".  Une
fenêtre affiche la liste des fichiers de contour contenus
dans le répertoire de référence.  Cliquez 2 fois sur
"FRANCE3.CFF".  Le signe "V" doit apparaître à gauche de
"FRANCE3.CFF".  Dans la même fenêtre, choisissez
"FRANCE1.CFF" de la même façon.  Cliquez ensuite 2 fois
sur "---Ok---" (dans le haut de la fenêtre).

5. Vous avez maintenant le choix du cadrage de la carte.
Choisissez "Fenêtrage automatique"

6. La carte de France s'affiche.

7. A l'aide de la commande "Zoom +" du menu "Affichage",
faites un zoom de la région méditerranéenne (comme sur la
carte ci-dessus).  La carte de la région sélectionnée
s'affiche.  Si le cadrage de vous satisfait pas, vous pouvez
revenir en arrière à l'aide de la commande "Zoom -".

8. On peut maintenant ajouter les contours des pays
limitrophes.  Choisissez la commande "Ajouter un contour"
dans le menu "Fichier".  Dans la liste des fichiers, cliquez
deux fois sur "ITALIA1.CFF" ou taper [Enter ] pour la
sélection.  La limite de l'Italie s'ajoute à la carte.  Répétez la
même opération pour le fichier "ESPA1.CFF".

9. Avant de sauver le fond, il faut définir les options
PostScript.  Dans le menu "Options", choisissez
"PostScript..." puis "Epaisseur des lignes".  Pour "Frontière
1", choisissez "Normal" et "Très Fin" pour "Frontière 3".
Toujours dans les options PostScript, choisissez "Grisé des
lignes"; choisissez "Noir" pour les 2 types de contour puis "-
--Ok---" pour valider.

10. Vous pouvez maintenant sauver le fond de carte.
Choisissez la commande "Sauver fond actuel" dans le
menu "Fichier".  CFF vous demande un nom de fichier de
sauvegarde.  Tapez, par exemple, EXEMPL.  CFF vous
demande ensuite le nom du fichier PostScript associé et
propose, par défaut, le même nom qu'à l'étape précédente.
Pour ces 2 fichiers, ne donnez pas d'extension; CFF ajoute
automatiquement l'extension DSC au fichier de description
et PS au fichier PostScript.
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11. Le fond de carte est sauvé.  Vous pourrez le récupérer
ultérieurement via la commande "Charger un fond" du
menu "Fichier".  L'affichage et l'impression seront beaucoup
plus rapides qu'en mode vectoriel.

6.4. Ajouter la distribution de 2 espèces sur la carte
précédente

Les distributions à ajouter sont celles de deux Hyménoptères
Sphecidae: Crabro peltatus et Ectemnius kriechbaumeri.  Ces cartes
ont été publiées dans LECLERCQ & BARBIER (1993).

Voici la carte que l'on désire obtenir:

✖✖

✖

✖

✖

✖
✖

✖

✖✖

✖✖

✖

✖

✖

✖

✖

✖
✖
✖

✖✖
✖✖

✖

✖

✖

✖
✖

✖✖

✖
✖

✖

✖

✖

✖ ✖

✖

Crabro peltatus   281 spécimens, 82 données

Ectemnius kriechbaumeri   95 spécimens, 73 données✖

(c) CFF 1.0 - 1995

Etapes:

1. Dans CFF, choisissez "Charger fond carte" dans le menu
"Fichier".  Dans la liste des fichiers, sélectionnez le fichier
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de l'exemple n˚3 (si vous avez suivi les instructions, le
fichier s'appelle EXEMPL.DSC) et validez votre choix en
tapant [Enter ] ou en cliquant 2 fois sur le nom.

2. La carte s'affiche.

3. Dans le menu "Options", choisissez "Type de symboles".
Choisissez "Rond (o)" pour le symbole 1 et "Croix (X)" pour
le symbole 2.

4. Dans le menu "Fichier", choisissez "Ajouter une
distribution".  Dans la liste des fichiers proposés, choisissez
"CRAPEL.DEG".  Une fois le fichier sélectionné, CFF
demande de choisir un type d'affichage de la distribution.
Choisissez "Un symbole pour toute la distribution".  CFF
vous demande alors de préciser le diamètre des symboles.
Le diamètre doit être exprimé en mètres.  Entrez 10000
comme valeur.  La distribution de Crabro peltatus s'affiche.

5. Faites la même opération pour le fichier "ECTKRI.DEG".
C'est la distribution de Ectemnius kriechbaumeri qui
s'affiche cette fois.

6. Vous pouvez imprimer cette carte au moyen du menu
"Impression".  Les couleurs ou les grisés des symboles
peuvent être maîtrisés via la commande "PostScript..." du
menu "Options".  Comme grisé de symboles, choisissez
"noir" pour le symbole 1 et "blanc" pour le symbole 2.
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6.5. Ajouter, sur la carte de l'exemple 2, la
distribution d'une espèce avec des symboles de
taille proportionnelle au nombre de spécimens
ainsi qu'un quadrillage UTM et du texte
identifiant les pays

France

Espagne

Italie

Méditerranée

✖

Crabro peltatus                                                                 
Totaux: 281 spécimens, 82 données

Plus de 10 spécimens
6 - 10
Moins de 6
présence✖

(c) CFF 1.0 - 1995

Suiver d'abord les étapes 1 à 3 de l'exemple 3.

4. Dans le menu "Fichier", sélectionnez "Ajouter un contour".
Choisissez "UTM100.CFF" comme fichier à ajouter.  Le
quadrillage UTM de 100 km de côtés s'affiche.

5. Choisissez "Ajouter une distribution" dans le menu
"Fichier".  Choisissez "CRAPEL.DEG" comme fichier de
distribution.  Sélectionnez ensuite, comme type de
distribution, "Symboles proportionnels au nombre de
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spécimens".  CFF affiche une fenêtre avec les nombres
maximum de spécimens et de données rencontrés dans le
fichier.  Entrez 3 comme nombre de classes à distinguer.
Entrez ensuite, successivement, 10, 5 et 0.  Entrez 10000
comme diamètre des plus gros points.

6. La distribution s'affiche.

7. Dans le menu "Edition", choisissez la commande "Ajouter
du texte".  Entrer "France" comme texte.  CFF affiche un
rectangle dans le haut de la carte.  Déplacez ce rectangle
avec la souris et positionnez le sur la France.  Cliquez sur
le bouton gauche de la souris.  Sélectionnez ensuite, dans
la nouvelle fenêtre affichée, "16 pts" comme taille.

8. Répétez l'opération précédente avec "Espagne", "Italie" et
"Méditerranée".

9. Vous pouvez imprimer la carte.
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7. Trucs et astuces

Dans ce chapitre, vous trouverez quelques indications pour améliorer
les impressions PostScript de vos cartes.  Pour les mettre en oeuvre,
vous devez posséder des connaissances de base relatives au
DOS.  Vous devez au moins savoir sauver des fichiers sur disquette,
éditer des fichiers et les sauver sous forme ASCII.

L'idéal est d'avoir quelques notions de PostScript pour bien
comprendre le contenu des fichiers d'impression.  Il faut savoir que le
PostScript est un vrai langage de programmation, comme le C ou le
BASIC.  Il est donc possible de modifier les fichiers d'impression, qui
sont en fait des programmes, pour changer le résultat obtenu.  On
trouvera une liste des ouvrages spécialisés en PostScript dans la
bibliographie.

Avec ces quelques connaissances de base, vous pouvez facilement
modifier certains paramètres de l'impression.

7.1. Le fichier PROLCFF.PS

Ce fichier, appelé le prologue, contient une série de procédures qui
vont être appelées lors de l'impression de la carte.

Lors de l'impression, sur imprimante ou sur fichier EPS, le prologue
est toujours envoyé en premier lieu.  Ensuite vient la carte
proprement-dite (contours, distributions, textes).

Si vous modifiez une définition du prologue, elle sera prise compte
lors de toutes les impressions ultérieures.  Pour modifier les
définitions du prologue, éditer le fichier PROLCFF.PS avec un éditeur
ou un traitement de texte.  N'oubliez pas de le sauvegarder toujours
en ASCII.
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Dans le prologue, toutes les lignes commençant par le caractère %
sont des commentaires.  Ceux-ci servent à rendre plus
compréhensible le programme.  Les lignes qui commencent par %%
sont des commentaires structurés un peu spéciaux; il ne faut pas les
modifier.

Voici quelques exemples de modifications faciles.

Changer l'épaisseur du cadre

A la première ligne commençant par /ec , changer .1  en 1.

L'épaisseur du cadre sera plus importante (l'unité est le point, soit
environ 1/72 de pouce ou 0,3 mm).

Changer les symboles ZapfDingbats

Les symboles 2 à 7 sont en fait repris de la police de caractères
ZapfDingbats.  Il est très facile de changer les caractères par défaut.
Ces symboles sont définis dans le prologue sous les procédures /s2

à /s7  ou /sc2  à /sc7  pour les symboles en couleur.

Par exemple, pour obtenir une étoile ❋ au lieu de la croix ✚, changez
la ligne

"/s2 {gris xd 1 SymbZapf eq {(:) zapf } {s2ai}
ifelse bd "

en

"/s2 {gris xd 1 SymbZapf eq {(k) zapf } {s2ai}
ifelse bd "

le caractère ":" correspond, en ZapfDingbats, à la croix alors que le
caractère "k" de la même police correspond à l'étoile (voir table des
caractères en annexe).
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Modification des épaisseurs de lignes

Les épaisseurs de lignes sont maitrisées par les procédures
EpTresFin , EpFin , EpNorm, EpGras  et EpTresGras .  Si, par
exemple, vous trouvez que l'épaisseur "Très fin" est trop fin,
augmenter la valeur indiquée dans cette procédure (.1  par défaut).

Changement de la police par défaut

La police de caractère prise par défaut est définie par la procédure
PolDef.  Si, par exemple, vous préférez la police de caractère
AvantGarde, remplacez /Helvetica par /AvantGarde-Book dans cette
procédure.

Les polices de caractères disponibles dépendent de l'imprimante
PostScript ou de l'interpréteur utilisé.  Les polices suivantes sont
généralement disponibles:

Courier Bookman-Demi
Courier-Bold Bookman-LightItalic
Courier-Oblique Bookman-DemiItalic
Courier-BoldOblique Times-Roman

Helvetica Times-Bold

Helvetica-Bold Times-Italic

Helvetica-Oblique Times-BoldItalic
Helvetica-BoldOblique NewCenturySchlbk-Roman
AvantGarde-Book NewCenturySchlbk-Bold
AvantGarde-Demi NewCenturySchlbk-Italic
AvantGarde-BookOblique NewCenturySchlbk-
AvantGarde-DemiOblique BoldItalic
Helvetica-Narrow Palatino-Roman
Helvetica-Narrow-Bold Palatino-Bold
Helvetica-Narrow-Oblique Palatino-Italic
Helvetica-Narrow-BoldOblique Palatino-BoldItalic
Bookman-Light ZapfChancery-MediumItalic
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Changement de la police du titre

La police utilisée pour les titres de distributions (les noms des taxons)
est, par défaut, Palatino-BoldItalic .  Vous pouvez changer
cette police par défaut dans la procédure PolTitre de la même façon
qu'au point précédent.

7.2. Ajouter une trame dans des fichiers PostScript
associés à des fichiers de sauvegarde

Les fichiers PostScript associés à des fichiers de sauvegarde
peuvent être modifiés de la même façon que le prologue.  Le contenu
en est cependant moins compliqué car il est pratiquement
uniquement composé des contours géographiques.

Le fichier CORSTOSC.PS, livré avec le logiciel, est un exemple de
carte retouchée via le fichier PostScript associé.  Dans ce fichier, on
a ajouté une trame qui représente la mer méditerranée.

En PostScript, pour "peindre" une surface, il faut que celle-ci soit
fermée.  En d'autres termes, il faut que le point d'arrivée corresponde
au point de départ.  La commande PostScript "closepath " permet
de fermer automatiquement une courbe.

Quand la courbe est fermée, il est possible de la remplir au moyen de
l'instruction "fill ".  Avant d'utiliser cette commande, il faut préciser
une valeur de gris via l'instruction "setgray ".  Les valeurs de setgray
sétendent de 0 (noir) à 1 (blanc).  Par exemple, ".9 setgray "
donnera un gris clair.  Donc, pour remplir une surface avec du gris
clair, il faut d'abord s'assurer que la courbe est bien fermée, puis
exécuter ".9 setgray fill ".

L'instruction "fill " a pour autre conséquence d'effacer le contour en
mémoire.  Autrement dit, après l'emploi de cette instruction, il n'est
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plus possible de dessiner le tracé de la courbe.  Aussi, afin d'éviter la
perte du contour en mémoire par l'emploi de "fill ", on enchasse
cette instruction par la paire d'instructions "gsave " et "grestore ".
Donc, la procédure de remplissage et de traçage de la courbe
devient: "gsave .9 setgray fill grestore ".

Voici les étapes à suivre pour ajouter une trame à vos cartes:

1. Recopier, au début du fichier PostScript de sauvegarde (un
fichier sans prologue, sauvé dans le répertoire de
référence), les définitions de trame contenues dans le
fichier CORSTOSC.PS.  Ces lignes sont:

/SetFreq {currentscreen 3 -1 roll pop
setscreen} bind def

/SetAngle {currentscreen 3 1 roll pop 3 1
roll setscreen} bind def

/Trame {Lx Ly m Lx Uy l Ux Uy l Ux Ly l c
gsave 30 SetFreq 130 SetAngle .9 setgray
fill grestore 0 setgray s} bind def

Trame

2. La dernière ligne, "Trame", va remplir le cadre par du gris
.9 incliné à 130 degrés.  L'inclinaison de la trame est utile
quand on surimpose un quadrillage à la carte.  Elle
améliore la lisibilité du quadrillage et évite le moirage.

3. A présent que le cadre est entièrement gris, chaque portion
de territoire devra être remplie en blanc pour se superposer
à la trame grise.  C'est ici que l'opération est la plus
délicate.  Chaque segment de ligne commence par une
coordonnée suivie de "m" et se termine par une coordonnée
suivie de "s".  Pour les petites îles comme l'île d'Elbe, vous
verrez que la coordonnée d'arrivée est la même que celle
de départ.  C'est le cas le plus facile, la courbe est déjà
fermée.  Dans ce cas, il suffit d'ajouter, à la fin de la courbe
avant "s", la ligne suivante: "gsave .9 setgray fill
grestore ".

Dans la plupart des cas, les courbes ne sont pas fermées.
Pour la France (fichier FRANCE1.CFF), le contour est
constitué d'une multitude de petits segments.
Heureusement, ces segments se succèdent dans un ordre
logique et vont tous dans le même sens (horlogique).  Dans
ce cas, il faut joindre tous ces segments et fermer la



CFF - Manuel d'utilisation - 38

nouvelle courbe obtenue.  C'est seulement alors que l'on
peut remplir la surface de blanc.

Dans d'autres cas, seule une partie de la courbe apparaît dans
le cadre.  Le reste est en dehors.  Dans ce cas de figure, il
faut fermer la courbe en dehors du cadre (tout ce qui est
hors-cadre n'est pas imprimé).  Suivant la position de la
courbe sur le cadre, il faut ajouter 1, 2 ou 3 nouveaux
points hors-cadre qui vont permettre de la fermer.

Enfin, avec certains fichiers comme MFMWDB*.ALL, il est
presque impossible de fermer les courbes car les segments
constitutifs  s'affiche de façon désordonnée et dans des
sens divers.

7.3. Economiser beaucoup d'espace disque avec les
fichiers PostScript

Nous avons vu que les fichiers PostScript associés aux fonds de
cartes sauvegardés permettent un affichage et une impression
rapides des cartes.

A chaque impression d'un tel fichier, il est entièrement recopié dans
un nouveau fichier cible avec, en plus, le prologue et la distribution
proprement dite.

Quand on fait une grande série de cartes avec un même fond, le
nombre de fichiers générés finit par être grand et l'espace occupé sur
le disque dur peut être très important.

L'instruction PostScript "run " permet d'exécuter un fichier PostScript
externe.  C'est elle qui va nous permettre d'économiser beaucoup
d'espace disque dur.

Exemple concret:

1. renommez le fichier CORSTOSC.PS en CORSTOSC.@PS.
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2. créez un nouveau fichier CORSTOSC.PS et écrivez y,
comme seule ligne,
"(/banque/cartog/corstosc.@ps) run"  (sans les
guillemets!)*.

Comme vous pouvez le voir, le nouveau fichier CORSTOSC.PS

contient le chemin d'accès au fichier CORSTOSC.@PS.  Donc, cette
configuration peut très bien fonctionner sur votre machine mais pas
nécessairement sur celle d'un collègue.

De plus, l'instruction "run" n'est pas interprétable par une imprimante
PostScript.  Cette dernière ne peut lire sur votre disque dur. Il faut
donc toujours passer par un interpréteur (ex: GoScript) pour pouvoir
bénéficier de cette instruction.

Cette procédure, si elle économise de l'espace disque dur, ne devrait
être utilisée que localement, pour des fichiers qui ne seront pas
échangés avec d'autres personnes.

 

* Attention! En PostScript, il faut utiliser le "/" (slash) au lieu du "\" (backslash).
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8. Formats des fichiers

8.1. CFF.INI

Ce fichier est de type ASCII.  Il contient la sauvegarde des options
que vous déterminer en utilisant CFF.

Structure:

Le fichier est commenté.  Une ligne de commentaire précède
la valeur de la variable considérée.  Pour les options
relatives aux contours (couleur, ...), l'ordre est le même que
dans les fenêtres de CFF (Frontière 1, Frontière 2, ..., Grille
4, Grille 5).  Au total, ce fichier contient 179 lignes.

8.2. Fichiers de distribution DEG et RAD

Ces fichiers contiennent les coordonnées des distributions ainsi que
les paramètres associés.  Ce sont des fichiers de type ASCII.  Vous
pouvez créer une application qui génère ce genre de fichiers.  Ils
pourront alors s'afficher sur les cartes CFF.  Dans ce cas, respectez
scrupuleusement le format prescrit.

Structure (voir exemple ci-dessous):

● ligne 1: titre de la distribution;

● ligne 2: nombre total d'individus, de données et de carrés
UTM.  Le format doit être rigoureusement respecté: 14
caractères pour chaque composant;

● ligne 3: périodes distinguées.  Cette ligne contient les 3
périodes que l'on peut distinguer dans ce type de fichier.
S'il y a moins de 3 périodes distinguées, on indique les
périodes non utilisées par "0 - 0";

● ligne 4: nombres d'individus, d'occurences et de carrés par
période distinguée;

● ligne 5: non utilisée (uniquement un retour à la ligne);



CFF - Manuel d'utilisation - 41

● lignes suivantes: la distribution proprement-dite.

- caractère 1: numéro de la période (1 à 3)

- caractère 2: non utilisé dans cette version

- caractères 3 à 13: latitude du point considéré avec son
signe et en degrés décimaux

- caractères 14 à 21: longitude du point considéré avec
son signe et en degrés décimaux

- caractères 22 à 26: nombre de spécimens à cette
coordonnée

- caractères 27 à 31: nombre de données

● dernière ligne: fin du fichier (en toutes lettres)

Exemple de fichier de distribution *.DEG

ECTEMNIUS KRIECHBAUMERI
NINDTOT=000098 OCCTOT=000076 CARTOT=000000
 0000 - 1949   1950 - 1995   0 - 0
NIND1=000011 OCC1=000011 CAR1=000000 NIND2=000087 OCC2=000065
CAR2=000000

2K+45.16486  +5.73563    1    1
1K+44.44551  +5.70182    1    1
2K+44.44551  +5.70182    3    2
2K+44.26265  +5.81870    2    2
2K+44.43930  +5.95283    1    1
2K+44.90088  +6.53023    1    1
2K+44.63371  +6.66767    1    1
2K+43.90594  +5.67728    3    1
2K+44.08580  +5.68538    2    2
2K+43.99288  +5.80589    3    3
2K+44.08280  +5.81014    8    5
1K+43.98975  +5.93043    1    1
2K+43.98975  +5.93043    3    3
1K+44.08280  +6.18986    2    2
2K+44.08280  +6.18986    1    1
2K+43.72606  +6.33075    1    1
2K+44.17574  +6.31054    1    1
1K+44.44842  +6.42372    1    1
2K+44.00145  +6.56787    1    1
2K+44.09140  +6.56419    7    7
1K+44.00404  +6.69249    2    2
2K+44.00404  +6.69249    6    4
1K+44.27391  +6.68195    1    1
1K+44.36386  +6.67841    1    1
2K+43.64661  +6.83021    1    1
2K+44.09878  +6.93867    1    1
2K+43.83670  +7.44523    6    2
1K+43.36336  +5.77668    1    1
2K+43.36336  +6.22332    6    3
2K+42.40652  +2.93924    1    1
2K+42.83900  -0.98105    1    1
2K+42.74679  -0.86188    1    1
fin du fichier
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Les fichiers *.RAD ont la même structure que les *.DEG.  Les
coordonnées sont cependant exprimées en 1/10000 de radians.  Un
exemple d'un tel fichier est donné ci-dessous.  Les coordonnées
occupent moins d'espace que dans les fichiers *.DEG.  Les fichiers
*.RAD, moins précis que les *.DEG, sont maintenus pour assurer la
compatibilité avec Microbanque Faune-Flore (RASMONT ET AL, 1993).

SCELIPHRON CAEMENTARIUM
NINDTOT=000530 OCCTOT=000394 CARTOT=000000
 0000 - 1949   1950 - 1994   0 - 0
NIND1=000006 OCC1=000006 CAR1=000000 NIND2=000524 OCC2=000388
CAR2=000000

1K 8512   363    2    2
2K 7554   604    2    2
2K 7554   615    2    2
2K 7633   616    0    2
2K 7613  1165    4    4
2K 7429  1534    2    2
2K 7311  1629    2    2

fin du fichier

8.3. Fichiers de contour CFF, PRN et ALL

8.3.1. Fichiers CFF

Pour des raisons de droits d'auteur, le format des fichiers CFF n'est
pas donné (voir chapitre 1).

Les fichiers CFF sont au format binaire.  Ils sont nettement plus
rapides en lecture que les fichiers ASCII et, pour une même quantité
d'information, occupent moins d'espace disque.

Les fichiers CFF de la C.E.E. (fichiers "NUTS") présentent souvent
des redondances par le fait que des frontières communes se
chevauchent.  Cela est du au fait que chaque segment est une
courbe fermée.  Par exemple, pour le fichier FRANCE3.CFF, chaque
contour de département figure dans sa totalité.  A l'intérieur du pays,
chaque segment est donc répété deux fois.
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L'utilitaire CFFCONV.EXE permet de convertir un fichier PRN (voir ci-
dessous) en un fichier de type CFF.

8.3.2. Fichiers ALL

Les fichiers ALL sont au format binaire.  Leur format est celui du
célèbre fichier "Micro World DataBank". Ces fichiers font partie du
domaine publique.

Le fichier MFMWDB2.ALL est un dérivé du fichier MWDBII.ALL.  Il
est identique à l'original exepté le fait que l'on a supprimé la frontière
de l'ex Allemagne de l'Est ainsi que les couloirs aériens qui
couvraient l'ex Allemagne de l'est.

Structure:

Chaque enregistrement est composé de 3 integers (2 bytes
chacun)

En Basic, la structure est la suivante:

 TYPE Micro
        Code AS INTEGER
        Latitude AS INTEGER
        Longitude AS INTEGER
      END TYPE

Code est utilisé pour décrire le noeud dont les coordonnées
suivent.  Le chiffre des milliers indique le type de contour: 1
pour les côtes*, 2 pour les frontières de pays, 3 pour les
Etats d'Amérique, 5 pour les îles, 6 pour les lacs et 7 pour
les rivières.

Latitude  et Longitude  sont exprimées en minutes par
rapport à l'équateur pour les latitudes et par rapport au
méridien de Greenwich pour les longitudes.

 

*Vu que ce type de contour n'est pas géré par CFF, ce type de ligne est contrôlé
comme s'il s'agissait de canaux.
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8.3.3. Fichiers PRN

Ces fichiers sont de type ASCII.  Ce sont les fichiers utilisés par le
logiciel VMAP pour les contours ou les distributions.

Structure:

Les lignes sont composées de 3 éléments au minimum.  Ces
trois éléments sont séparés par un ou plusieurs espaces.

Premier élément: -1 ou 0.  -1 signifie au programme qu'il faut
commencer un nouveau contour.  0 indique la poursuite du
contour entamé.

Deuxième élément: latitude en degrés décimaux.

Troisième élément: longitude en degrés décimaux.  Il doit se
terminer par le caractère ":".

Quatrième élément (optionnel): un commentaire.  Celui-ci ne
doit comporter ni blanc, ni virgule, ni caractères
d'opérations mathématiques.

exemple de fichier PRN:

-1 +49.6819  +5.8153:SEMOIS
0  +49.6773  +5.8062:
0  +49.6785  +5.7970:
0  +49.6811  +5.7909:
0  +49.6839  +5.7906:
0  +49.6871  +5.7925:
0  +49.6906  +5.7916:
0  +49.6932  +5.7908:
0  +49.6943  +5.7891:

L'utilitaire CFFCONV permet de transformer un fichier PRN en fichier
CFF.  Deux avantages sont tirés de cette conversion: la rapidité et
l'exploitation de la hiérarchie des contours.
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8.4. Fichiers menus et messages

8.4.1. Fichiers menus

Le texte des menus est contenu dans les fichiers CFFMENU.* (le *
désigne la langue: FR=français, EN=anglais, ES=espagnol, DE=
allemand, IT=italien et NE=néerlandais).

Si vous décidez d'adapter ou de corriger ce fichier, veillez
absolument à respecter le format.  Un bon conseil: avant toute
modification, faites un backup de vos fichiers!

Les items sont donnés dans l'ordre où ils apparaissent à l'écran, en
commencant de gauche à droite et de haut en bas.  Chaque ligne
comporte 2 entrées séparées par une virgule: le texte (entre deux "")
et le numéro de la lettre qui servira de raccourci (la première porte le
numéro 0).  Un extrait du fichier CFFMENU.FR est donné ci-après.

"Fichier",0
"Nouvelle carte",0
"Ajouter un contour",11
"Supprimer un contour",0
"Ajouter une distribution",12
"Supprimer distributions",2
"-",0
"Charger un fond",11
"Sauver le fond actuel",3
"-",0
"Sauver les réglages",11
"Charger les réglages",1
"-",0
"Commande DOS",9
"Quitter           ALT+F4",0
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8.4.2. Fichiers messages

Comme pour les fichiers menus, ils portent une extension qui indique
la langue utilisée.  Leur format est cependant différent.  Ces fichiers
doivent absolument avoir une longueur fixe de 84 caractères +
retour chariot pour CHAQUE ligne .

Les lignes sont composées de la façon suivante:

1.  4 chiffres qui donnent le numéro de la ligne;

2. le message;

3. la fin du message symbolisée par le caractère ∞ (alt+236);

4. autant d'espaces qu'il faut pour arriver à 84 caractères.  A
la fin de chaque ligne, on a ajouté le caractère Ø (alt+237)
qui permet de se repérer facilement.

Dans toute modification de ces fichiers, il faudra veillez à ne pas
rédiger des messages dont la longueur dépasse celle du fichier
CFFMESS.FR qui est le fichier original.
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9. Marques déposées et
logiciels cités

PostScript  est une marque déposée de Adobe Systems Inc.
GoScript  est une marque déposée de LaserGo Inc.    GhostScript
est une marque déposée de Aladdin Enterprises.   Microsoft Word
est une marque déposée de Microsoft Corporation.  PageMaker  est
une marque déposée de Aldus Corporation.  PkZip  et PkUnzip  sont
des marques déposées de PKWARE, Inc.  Vmap  est un copyright de
Charles H. Culberson.  Times , Helvetica , Palatino  et New Century
Schoolbook  sont des marques déposées de Allied Corporation.
Bookman , ZapfChancery , ZapfDingbats  et AvantGarde Gothic
sont des marques déposées de International Typeface Corporation.
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Distributions 40 Prologue 33
Droits d'auteur 1 PS 14
DSC 14, 15 RAD 17, 40
Edition 21 Récupération d'un fond de carte 15
Enlever du texte 21 Réglages 13
Epaisseur des lignes 20 RESUDEG 17
Epaisseur des lignes entourant les RESURAD 17

symboles 20 Run 38
Epaisseurs de lignes 35 Sauvegarde d'un fond de carte 14
EPS 33 Sauvegarde et rappel des options 
Fenêtrage 10  d'affichage 13
Fichier PCX 20 Sinusoïdale(projection) 16
Fichiers ALL 43 Statistiques 19
Fichiers CFF 42 Stéréographique (projection) 16
Fichiers PRN 44 Style 13
Fichier EPS 19 Suppression de contour 11
Formats 40 Supprimer distributions 18
Fuseau UTM 20 Symboles 18, 34
Gall (projection) 16 Symboles proportionnels 18
Grille UTM 11 Titres distributions 21
Grisés des lignes 20 Titre de la carte 21
Grisés des symboles 20 Trame 36, 37
Impression 19 Types de symboles 18
Install 6 Unités 21
Installation 4 UTM (projection) 16
Lambert (projection) 16 VMAP 44
Légendes distributions 21 Zoom 11
Maille 22
Mappemondes 16
Marge 13
Matériel conseillé 3
Matériel requis 3
Mercator (projection) 16
Méridien central 20
Micro World DataBank 43
Miller 16
MODE CO80 6
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1. Copyrights

Warning

The authors assume no liability for damages, direct or
consequential which may result from the use of CFF.

CFF is a free-copy software (according to the shareware principle).
After a one-month-evaluation period, if you are satisfied with the
software, you are invited to pay a contribution to the authors (3000
BEF, 500 FF, 140 DM).  If not, you must remove the software and all
its annex files from your computer.  After the payment of your
contribution, you will be registered as official owner of the software.  It
will allow you to get a complete user's manual, boundaries files, utility
programs, and information about the software's development.

The MWDB*.ALL (Micro World Data Bank) has entered the public
domain through Fred Pospeschil and Antonio Riveria.  These files are
the compressed version of the original WDB-II file produced by the
Central Intelligence Agency (CIA).

The boundaries files from the European Community can only be used
with CFF.  They must not be delivered or sold to a third-party.  These
files were created from the NUTS3 file of the Office Statistique des
Communautés européennes (Eurosat, Luxembourg) and are the
following:

ACORES1.CFF BULGARI1.CFF EIRE1.CFF
ALBANI1.CFF CANARI1.CFF EIRE3.CFF
ALGERIE1.CFF CH1.CFF ESPAGN1.CFF
ANDORRA1.CFF CHANNEL.CFF ESPAGN3.CFF
AUSTRIA1.CFF CORSE1.CFF ESPMARO.CFF
BALEAR1.CFF DENMARK1.CFF EXYOUGO1.CFF
BELG1.CFF DENMARK3.CFF FINLAND1.CFF
BELG2.CFF DEUTSCH1.CFF FRANCE1.CFF
BELG3.CFF DEUTSCH2.CFF FRANCE3.CFF
BELG4.CFF DEUTSCH4.CFF HELLAS1.CFF
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HELLAS3.CFF NEDERLA1.CFF TCHEQU1.CFF
HUNGARY1.CFF NEDERLA3.CFF TUNIS1.CFF
ICELAND1.CFF NORWAY1.CFF TURKWEST.CFF
ITALI1.CFF NUTSREST.CFF TURKEY.CFF
ITALI4.CFF POLAND1.CFF UK1.CFF
LIECHT.CFF PORTUGA1.CFF UK3.CFF
LUXEMB1.CFF PORTUGA3.CFF
MADEIR1.CFF ROMANIA1.CFF
MALTA1.CFF SLOVAK1.CFF
MAROC1.CFF SWEDEN1.CFF
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2. Material required

Equipment requirements

● PC computer with a 80x86 processor

● VGA card or upgrade (SVGA)

● MS-DOS 3.1 or upgrade

● A mouse

Recommended material:

● VGA colour screen

● 80486DX processor or upgrade

● Math coprocessor useful

Table I gives the display time of a big boundaries file for different
hardware and software configurations.

Table I.  Comparison of the display performances for different hardware and
software configurations.  Display time of the MFMWDB2.ALL file for
the GALL projection.

Configuration Display time

PC 80486 100Mhz 00'56"

PC 80486 66 Mhz with Stacker 01'17"
4.0

PC 80386 20 Mhz with 80387 05'42"
math coprocessor and Stacker

4.0

PC 80386 20 Mhz with Stacker 17'38"
4.0
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3.  Installation configuration

For a standard installation, run INSTALL program from the
disk driver.

The following files are needed for a proper use of CFF.  They are
delivered in compressed self-extracting version.

CFF.EXE CFF program
CFF.INI Parameters backup file
HELV*.GFN Screen font characters
PROLCFF.PS PostScript prologue
CFFMENU.* Menu files.  The extension specifies

the language used (FR=French,
EN=English, ES=Spanish,
NL=Dutch, DE=German, IT=Italian)

CFFMESS.* Messages files.  The extension
specifies the language used.

*.CFF Boundaries files (binary format)
*.ALL Boundaries files (binary format,

Micro World Data Bank structure)
*.DSC Saved maps description files
*.PS Saved maps printing files
*.PCX Saved maps screen copy
CFFCONV.EXE Utility designed to convert a PRN file

into a CFF file
CFFCONV.* Messages files for CFFCONV.  The

extension specifies the language
CFFGRI.EXE UTM, degrees and grades grids

generator
CFFGRI.* Messages files for CFFGRI.  The

extension specifies the language
CFFTABL.EXE Utility designed to capture maps

boundaries on a digitalising table
CFFTABL.* Messages files for CFFTABL.  The

extension specifies the language
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RESUDEG.EXE Utility designed to replace
RESURAD.EXE in the Microbanque
Faune-Flore software (RASMONT &
AL, 1993).

CARTEZ.BAT Replacement file for Microbanque
Faune-Flore (RASMONT & AL, 1993).

CFF.EXE may be found in any directory if the acces path is specified
(enter PATH in order to control or PATH=access path  in order to
update).

When it is launched, CFF looks for the CFF.INI initialization file.
C:\BANQUE is the default directory in which CFF will first look for the
file.  If it is not found, it is searched in the root directory of all the hard
disks connected to your computer.  If it is not found, it is searched in
the current directory.  Finally, if CFF.INI can not be found, CFF
chooses default values and asks the name of the reference directory.
This directory contains the underlined files of the previous list.  The
name of this directory must be specified.  If not, CFF can't function.

The CFF.INI file format is explained in chapter 8.

If you are a Microbanque Faune-Flore user, the RESUDEG.EXE file
must be copied in the C:\BANQUE\MICROBAN directory.

For monochrome screens, the following DOS command must be
typed before CFF: MODE CO80.  If not, the program doesn't work.

Installation example

Directory (structure advised) files

C:\BANQUE CFF.INI
C:\BANQUE\CARTOG *.CFF, *.ALL, *.PS, *.DSC,

*.PCX, CFFMENU.*,
CFFMESS.*, *.CFG

C:\BANQUE\MICROBAN *.EXE



CFF - User's manual - 54

This corresponds to the default settings achieved by the install
program.

Working language

CFF is a multilingual program.  English is the default language.  If you
want to use another language, click the "options " menu and then
"language" in order to select the appropriate language.  The menus
and messages are now displayed in the chosen language.  In this
version, only 3 different languages are available: french, english and
spanish.
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4. Possibilities offered by CFF

CFF is a mapping software for biogeographers.  It is designed for the
making of distribution maps of animal or vegetal taxa.

A large number of boundaries files can be superimposed.

The distributions can be displayed in different ways:

● simple presence (1 symbol by taxon, maximum 5 taxa by
map);

● presence according to 1, 2 or 3 periods (1, 2 or 3 different
symbols for the same taxon);

● symbols whose size is a function of the number of
specimens or data.

9 projections are available: Lambert conic, Stereographic, Mercator,
Plate Carrée, Miller Equirectangular, BSAM (Bolshoi Sovietsky Atlas
Mira), Gall, Generalized cylindrical and Sinusoidal.

The central meridian is calculated automatically or to correspond to
the centre of the nearest UTM zone (it  allows for correct display of
the UTM grid pattern), or it is your choice.

The maps can be printed with a PostScript printer or in EPS files
(Encapsulated PostScript).  These latter can be included in a word
processor or pagemaking software.  Draft screen copies can be
printed on a non PostScript printer.  It is also possible to make a
backup copy of the screen in a PCX-type file.

Editing the map's legend, adding text string or drawing polygons on
the map is also possible.

The parameters of colour, thickness, lines styles and symbols are of
your choice.
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5. Operation guide

5.1. Mapping

Before starting, you need to understand the two working modes of
CFF.

Two possibilities are offered for mapping:

1. The vectorial mode

2. The mixt mode

The vectorial mode

The map is displayed by means of the map file(s) which contain the
geographic coordinates of the boundaries (CFF, ALL or PRN files).
With this kind of map, you can zoom in or out at will.  Anytime the
map is displayed, all the boundaries files concerned are read.

The mixt mode

The map is displayed from a picture stocked on the hard disk in the
form of a PCX file.  This kind of map allows a very quick display but
zooming or changing the projection's parameters is impossible.  A
PostScript vectorial file corresponding exactly to the layout of the
displayed map is saved.  This vectorial file is used for the working-out
of the printing files.  Therefore there isn't any resolution loss  when
using the mixt mode.
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Choice of a display mode

The zooming possibilities of the vectorial mode makes it the more
powerful of the two modes.  But, the relative slowness of the display
becomes a serious handicap when the map  background is
complicated or when the computer has a slow processor or lacks a
math coprocessor.  In this case, the best course of action is
definitively setting the map background in the vectorial mode and
then saving it in order to use it later in the mixt mode ("Save current
background " option of the "File " menu).

Making a new map

To make a new map, select "New map " from the "File " menu and
then CFF displays the list of the boundaries files available in the
reference directory (the name of this directory is specified in the
CFF.INI file).  In the list, highlight the files which you want to appear
on the map.  The selected files have the "V" checkmark in front.  To
stop the selection of the files, select "----Ok----" in the top of the
window.

The program allows you to choose between two windowing methods:
automatic or manual.  The automatic windowing includes all the files
that you have previously selected (except the files of the geographic
grid).  With the manual windowing, you need to specify the maximal
and minimal longitudes and latitudes of the window.

CFF displays a window and plots a map in it.  The percentage of the
processed files scrolls in the bottom of the window.  You can interrupt
the current file's display by pressing the [ESC] key or by clicking the
right-hand mouse button.

When the mouse pointer appears on the map, CFF gives its
geographic coordinates.
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Adding boundaries

To add an extra boundary (UTM grid, e.g.), select "Add boundary "
from the "File " menu.  Highlight the file you want in the list.  CFF
automatically adds the boundary to the map.

Removing boundaries

To remove a boundary, select "Remove boundary " from the "File "
menu.  Select the file you want to remove.  Validate your selection by
pressing the [Enter ] key or by double-clicking  the filename.  Repeat
the operation as much as wanted.  Exit the window by pressing the
[ESC] key or by clicking the right-hand mouse button.  You can then
chose to redraw the map or not.

 Zoom

The zoom is available only in the vectorial mode (see above).

You can zoom using the mouse as following:

● select "Zoom + " from the "Display " menu.  The mouse
pointer is modified and its movement is limited to the space
occupied by the map.

● Click the left-hand mouse button in the upper left corner of
the new window and hold it down.

● Bring the mouse pointer to the bottom right corner of the
part you want to zoom and release the button.

● CFF asks for confirmation before displaying the zoom.

You can zoom as much as you want.  Nevertheless, for large scales,
the program suffers from a lack of precision and behaves in an
unpredictable way.  In the current version, you can't display an area
whose surface is smaller than 1 km2.
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Anytime the zoom command is activated, the projection parameters
are re-calculate.  Therefore, the original centering is modified.  To
make an accurate work, it is recommended to adjust the zoom
progressively, step by step.

The "Zoom - " command from the "Display " menu allows you to
display the previous zoom.  If there isn't any previous zoom (as when
the initial map is displayed), CFF suggests a manual zoom.  Type in
the new coordinates of the window.

Display options

The display options allow you to control the colour, the style and the
visibility of the different types of boundaries.

The *.CFF boundaries files include up to 5 different types of
boundaries:

● borders

● rivers

● canals

● lakes

● geographic grids

Each type of boundary can have up to 5 levels of importance.  The
levels go from 1 to 5 (level 1 being the more important).  For instance,
France's borders have level 1 while the boundaries of its departments
have level 3.

The display options allow you to control the visual appearance of all
the boundaries according to their own level.

To modify the colour, select the "Lines colour " option from the
"Options " menu.  For each line you can choose the colour you want.
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If you don't want a type of line to appear, select "no colour" as
line colour .

To modify the style, select "Lines style " from the "Options " menu.

To modify the colour of the map background, select "Background
colour " from the "Options " menu.  Once the new colour is selected,
CFF replaces the old colour of the map background with the new one.

If you want to control the position of the left side of the map, select
"Margin " from the "Display " menu.  This option is particularly useful
for screen printings.  Once this option is selected, CFF materializes
the margin by a vertical line which appears on the left side of the
screen.  Position the new margin using the mouse and click the left-
hand button to validate your choice.  The new margin setting will be
used at the next display of the map (choose redraw or press F5 to
redraw).

Saving and loading display options

The "Save settings " command from the "File " menu allows you to
save all the display options in a file.  These options can be loaded
later with the "Load settings " command.  These files have the
"*.CFG" extension and are saved in the reference directory.

The saved options are: map background colour (1), boundaries
colours (24), boundaries styles (24), boundaries thickness (24),
boundaries setgray (24), symbols (5), symbols setgray (5), symbols
thickness (1), PostScipt symbol colour (5), PostScript lines colours
(24), symbols display colour (5) and display mode for PostScript
symbols (1).
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Saving a map background

Once the map is computed, you can save it (see mixt mode above).
Before saving the map background, check all the PostScript
options of the lines  (see below).

The "Save current background " command from the "File " menu
allows you to save the map background.  CFF asks the name of the
PostScript file associated to it.  It is advised to keep the name of the
previous file, given in default.

The process generates 3 files which will be included in the reference
directory of the boundaries files (in default: C:\BANQUE\CARTOG).
The 3 files are:

1. the file with the DSC extension.  This ASCII file contains the
parameters of the projection and the map's layout;

2. the file with the PCX extension.  This binary file contains
the "bitmap" picture of the displayed map;

3. the file with the PS extension.  This ASCII file is the
PostScript file corresponding to the map.  This file will be
used anytime the map is to be printed.

Loading a map background

The "Load background " command from the "File " menu is used to
load a map background previously saved with the "Save current
background " command.

CFF displays a window which shows all the *.DSC files in the
reference directory.  Select the file you need by pressing the [Enter ]
key or by double-clicking the file name.
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CFF displays the saved map.  Then you can work on it as you would
on another map but with the following restrictions:

● you can't zoom in or out;

● you can't remove the lines included in the saved map;

● you can't modify the visual appearance of the saved lines;

● you can't modify the projection.

5.2. Projection choice

The map projection you will use determines the way the spherical
coordinates (latitude, longitude) will be transformed in planar
coordinates (x, y) on the screen or on paper.

In fact, it is impossible to transform the spherical coordinates into
plane coordinates without causing distorsions in the representation of
the surfaces, angles or distances.  As a result of the projection you
select, the distorsions will be more or less noticeable and will affect
the distances, the angles, the surfaces or the three parameters at
once.

Traditionally, the map projections are classified in four families
according to the distorsion they cause:

● conformal projections : respect angles but neither
surfaces nor distances (Lambert projection, stereographic,
UTM, Mercator, Miller, BSAM, Gall);

● equal-area projections : respect surfaces but not forms
(Bonne projection, not implemented in this version);

● equidistant projections : respect distances along some
prevailing lines (Plate Carrée projection, sinusoidal );

● aphilactic projections : does not respect any of the
elements described above.

In the CFF software, the projections are classified in conics,
cylindricals or pseudocylindricals.  These distinctions are made in
response to the nature of the projection surface used.
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The cylindrical projections are suitable for world maps or for maps of
low to medium-latitude regions (about -75˚ to +75˚).  Some cylindrical
projections cause noticeable surface distorsions in polar regions
(Mercator projection, e.g.).  Their use must be limited to the mapping
of intertropical regions.

The Lambert projections are well suited for medium-latitude regions,
such are found in Europe or in North America.  They provide a very
good representation of the UTM grid patterns.  In the current version
of CFF, they can't be used for the southern hemisphere.

The polar stereographic projection is well adapted to high latitudes
(northern or southern) regions.

The sinusoidal and Plate Carrée projections are usually unsightly but
they have a quick display.

To summarize, it is advisable to choose:

● a Lambert projection for maps of medium-latitude regions
(from 25˚ to 78˚) and for relatively large scale (of the order
of the continent), particularly if a UTM grid pattern is added
to the map;

● a cylindrical projection for world maps, preferably one which
would alleviate the distorsions of the polar regions (Gall or
BSAM e.g.).

5.3. Display of the distributions on the map

Once the background is achieved, you can add symbols which will
represent the distribution of one or more taxa.

To add a distribution, select the "Add a distribution " command from
the "File " menu.  CFF displays a window containing a list of the
current directory's files which have the .DEG or .RAD extension.
These files must absolutely respect the correct format (see chapter 8
for explanation of this format).  They are generated by Microbanque
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Faune-Flore via the old RESURAD module or the new RESUDEG
module (delivered with this software).  RESURAD and RESUDEG
make a file (RESUME.RAD or RESUME.DEG) which contains the
coordinates of the distribution points.  The coordinates included in the
.RAD file are expressed in 1/10000 of radians while in the .DEG file
they are expressed in decimal degrees (5 decimals, metrical
resolution).  The .DEG files are significantly more accurate than the
.RAD files; therefore you must avoid using the .RAD files for large
scale maps (large magnification).

CFF gives then the choice between 4 distribution display modes:

1. by period: the periods which are indicated in the distribution
file header are taken into account.  The distribution is
represented with as many symbols as the number of
periods, with a maximum of 3 periods.  The symbols
selected are n˚3 for the oldest period, n˚2 for the interim
period and n˚1 for the most recent period.  With this mode,
you can't only display one distribution at a time.

2. by fixed symbols: the distribution is represented by one
symbol or directly by the number of specimens whatever
the period.  Up to 5 distributions on one map can be held
simultaneously.

3. by symbols proportional to the number of specimens: the
distribution is displayed with the symbols whose size is
directly proportional to the number of the specimens
registered for each coordinate.  The division in classes is
up to you.  In order to help you to make class divisions,
CFF displays the maximum values detected in the file.

4. by symbols proportional to the number of data: the principle
is the same as in 3.  but here it is the number of data that is
taken into account and not the number of specimens.

After having selected the display type, the distribution is displayed on
the map.  In order to modify the type of the symbols, select the
"Symbols " command then "Types of symbols " from the "Options "
menu.  "Symbols colours " is used to modify the colours of the
symbols displayed.
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In order to remove the distribution(s) displayed without erasing the
map background, select the "Remove distributions " from the "File "
menu.

5.4. Statistics about the distributions displayed

When one or several distributions are displayed, the "Statistics "
option from the "Display " menu is used to delimit a frame using the
mouse and obtain the available pieces of information for this
geographical frame.  According to the type of display you have
selected, CFF gives the number of specimens and data for each
period or taxon.  You can save the result in a ASCII file and then load
it from a word processor.

5.5. Printing

The "Printing " menu is used to print directly via a printer or indirectly
via a PostScipt file.

The "Printer... " command from the "Printing " menu gives the choice
between 4 types of printer.  The final results are different from one
printer to another: for the "dot-matrix ", "Deskjet " and "LaserJet "
printer, the final result of the printing is the same as a simple copy of
what appears on the screen.  The result doesn't correspond to what
you expect but you can use it as a quick rough copy.  On the
contrary, the choice of a PostScript printer gives excellent results if, of
course, you have such a printer.

The "Black & white EPS file " and "Colour EPS file " commands
generate files with a "Encapsulated PostScript" format.  These files
can be integrated in software as Word, PageMaker by which the
layout can be worked out before printing with a PostScript printer.
Most of the time, these files are printed on any type of printer thanks
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to PostScript interpreter software.  Some of these software are in the
public domain*.

In PostScript mode, you can control the visual appearance of all the
parameters of the map or the distribution with the "Options " menu.
In this menu, the changes made in lines styles or symbols will have a
consequense on the PostScript printings.  The "PostScript... "
command of this menu is used to control other parameters: lines
thickness, lines setgray, lines colours, symbols setgray, thickness of
lines surrounding the symbols, symbols colour.  These line
parameters can't be controled on the maps which are loaded with the
"Load background " command in the "File " menu.

The "Printing " menu is also used to save what appears on the
screen in the form of a PCX file.  You can load this file from "bitmap"
drawing software such as PaintBrush, if you want to make any
changes.

5.6. Other options

The other commands in the "Options " menu are:

● "Central meridian ": in order to modify the meridian used as
the reference center of the map.  By selecting
"Automatically centered on the nearest UTM zone", the
central UTM grid pattern will always be straight (as long as
the projection you've selected is a Lambert projection).

● "Projection ": in order to select the type of projection you
want.  The most aesthetical projection, for medium-latitude
regions, is the Lambert projection.

● "Units ": in order to modify the units linked to the
distributions.  In default, the units are "specimens" and
"data".

 

* GhostScript, available on the Internet (FTP server) at the adress ftp.cs.wisc.edu, is
a good interpretor of this type.  GoScript (LaserGo Inc., 9369 Carroll Park Drive Suite
A, San Diego, CA 92121 USA, tel (619) 450 4600, Fax (619) 450 9334), sold for
about 80$, gives perfect results.
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5.7. Adding and modifying elements on the map

The "Edit " menu is used to add or modify some elements of the map.

"Map title " is used to add text string in the bottom right corner, under
the frame.

"Distributions title " is used to modify the titles of the distributions.
The default titles are the names of the concerned taxa (see chapter 8
for the DEG and RAD files structure).

"Distributions legend " is used to modify the text string relative to the
distributions text strings.  In default, this text string consists of the
number of individuals and of the data of the concerned taxon.

"Add text " is used to add a text string anywhere on the map.  CFF
first asks for the text string.  Then, you are invited to choose the size
(in points) of the text string.  CFF then draws, in the top left corner of
the map, a rectangle which represents the space occupied by the text
string.  Drag this rectangle using the mouse and choose its position.
Validate the new position by clicking the left-hand mouse button.
During the PostScript printing, the text string might not occupy the
exact space then displayed on screen.  The reason is that the screen
font doesn't correspond to the PostScript font.  The common
reference point to both systems is the top left corner of the frame
which contains the text string.

"Remove text " is used to remove text string previously placed using
the preceeding command.  CFF displays the list of the text strings
present on the map.  Select the text string(s) you want to remove by
double-clicking it with the left-hand mouse button or using the [Enter ]
key.  Exit the window by clicking the right-hand mouse button or
pressing the [ESC] key.  In order to update the map, press the [F5]
key or select the "Re-display map " command from the "Display "
menu.
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"Scale... " is used, during its primary use, to add a scale to the map.
CFF asks for the distance which it represents with an horizontal line.
In order to help you, CFF gives the maximal width of the map (in km).
Type a value inferior to this maximum.  CFF asks you to place the
horizontal line on the map.  Move this line using the mouse and click
to position it.  In order to move or to remove the scale, select once
again "Scale... " from the "Edition " menu.

"Add a polygon ", from the "Edition " menu is used to draw straight
lines on the map.  First, click a starting point.  Then, move the mouse:
a line segment is displayed and its movement is linked to the mouse's
movement.  When this segment is in the right position, click the left-
han button to set it.  As long as you don't click the right button, CFF
remains in "draw polygon" mode.

The "Graticule " command from the "Display " menu is used to add a
graticule to the current map.  The interval between two points of the
graticule is of your choice.  The graticule is not "sticked" on the map:
it disappears in case of re-displaying or in case of zooming.  During
the PostScript printing, CFF asks if you want to print a graticule on
the map or not.  1 is the default value; delete this value if you don't
want a graticule on the printed map.
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6. Examples of CFF in action

6.1. Making a map of France

The goal is to get a map of France with only its national borders.

(c) CFF 1.0 - 1995

Here is what to do:

1. In CFF, first select the display options using the "Options"
menu.

- Select "Background colour".  Double-click "Gray" with
the left-hand mouse button.
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- From the same menu, select "Lines colour".  Double-
click "Border 1" and select "Yellow" as colour.  Double-
click "---Ok---" to exit the window.

- From the same menu, select "Lines styles".  Select
"continuous" for "Border 1".  Double-click "---Ok---" to
exit the window.

2. From the "Options" menu, select "Projection" and choose
"Lambert conic" then "Automatic calculation of reference
parallels"

3. From the "Options" menu, choose "Central meridian" and
select "Automatically centered on the nearest UTM zone"

4. From the "File" menu, choose "New map".  A window
displays the list of the boundaries files contained in the
reference directory.  Double-click "FRANCE1.CFF".  The
"V" checkmark must appear to the left of this file.  Then
double-click "---Ok---" (in the top of the window).

5. You have now to select map's windowing.  Select
"Automatical windowing".

6. The map is displayed.

7. Before printing the map in PostScript mode, you need to set
up the printing options.  From the "Options" menu, select
"PostScript..." and then "Lines thickness".  Select "Normal"
for "Border 1".  Still in the PostScript options, select "Lines
setgray"; select "Black" for "Border 1" and then "---Ok---" to
validate.

8. You can now print the map using a PostScript printer or an
EPS file.  You can also definitively save the map
background (see example 6.3).
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6.2. Making a map of Belgium with the limit of the 3
regions and the 100 km-side UTM grid pattern

(c) CFF 1.0 - 1995

Here is what to do:

1. In CFF, first select the display options using the "Options"
menu.

- Select "Background colour".  Double-click "Gray" with
the left-hand mouse button.

- From the same menu, select "Lines colour".  Double-
click "Border 1" and select "Yellow" as colour.  Select
"White" for "Border 2" and "Black" for "Grid 1".  Double-
click "---Ok---" to exit the window.

- From the same menu, select "Lines styles".  Select
"continuous" for "Border 1" as well as for "Grid 1".
Select "dotted" for "Border 2".  Double-click "---Ok---" to
exit the window.
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2. From the "Options" menu, select "Projection" and choose
"Lambert conic".

3. From the "Options" menu, choose "Central meridian" and
select "Automatically centered on the nearest UTM zone"

4. From the "File" menu, choose "New map".  A window
displays the list of the boundaries files contained in the
reference directory.  Double-click "BELG2.CFF".  The "V"
checkmark must appear on the left of "BELG2.CFF".  In the
same window select according to the same way
"BELG1.CFF" and "UTM100.CFF".  Then double-click "---
Ok---" (in the top of the window).

5. You have now to select map's windowing.  Select
"Automatical windowing".

6. The map is displayed.

7. Before printing the map in PostScript mode, you need to set
up the printing options.  From the "Options" menu, select
"PostScript..." and then "Lines thickness".  Select "Normal"
for "Border 1"; then "Thin" for "Border 2" and "Extra thin" for
"Grid 1".  Still in the PostScript options, select "Lines
setgray"; select "Black" for the three types of boundaries an
then "---Ok---" to validate.

8. You can now print the map using a PostScript printer or an
EPS file.  You can also definitively save the map
background (see example 6.3).
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6.3. Making a reusable background map of southern
France with the boundaries of the bordering
countries

(c) CFF 1.0 - 1995

1. In CFF, first select the display options using "Options"
menu.

- Select "Background colour".  Double-click "Gray" with
the left-hand mouse button.

- From the same menu, select "Lines colour".  Double-
click "Border 1" and select "Yellow" as colour.  Select
"White" for "Border 3" and.  Double-click "---Ok---" to exit
the window.

- From the same menu, select "Lines styles".  Select
"continuous" for "Border 1" as well as for "Border 3" and
"Grid 1".  Double-click "---Ok---" to exit the window.

2. From the "Options" menu, select "Projection" and choose
"Lambert conic".
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3. From the "Options" menu, choose "Central meridian" and
select "Automatically centered on the nearest UTM zone"

4. From the "File" menu, choose "New map".  A window
displays the list of the boundaries files contained in the
reference directory.  Double-click "FRANCE3.CFF".  The
"V" checkmark must appear to the left of "FRANCE3.CFF".
In the same window, similary select "FRANCE1.CFF".
Then double-click "---Ok---" (in the top of the window).

5. You have now to select map's windowing.  Select
"Automatical windowing".

6. The map is displayed.

7. Using the "Zoom +" command in the "Display" menu, zoom
on the Mediterranean region (as on the map above).  The
map of the selected region is displayed.  If you are not
satisfied with the centering, you can zoom out using the
"Zoom -" command.

8. You can now add the boundaries of the bordering
countries.  Select the "Add boundary" command from the
"File" menu.  In this menu double-click "ITALIA1.CFF" or
press the [Enter] key to select.  The boundary of Italy is
added to the map.  Repeat the operation for the
"ESPA1.CFF" file.

9. Before saving the background, you need to specify the
PostScript options.  In the "Options" menu, select
"PostScript..." and then "Lines thickness".  Select "Normal"
for "Border 1" and "Extra thin" for "Border 3".  Still in the
PostScript options, select "Lines setgray"; choose "Black"
for both types of boundaries and then select "---Ok---" to
validate.

10. You can now save the map background.  Select the "Save
current background" command from the "File" menu.  CFF
asks for a file's name.  Type, for instance, EXEMPL.  CFF
asks then the name of the associated PostScript file, the
default name it suggests is the same as in the precedent
step.  For these two files, don't specify an extension; CFF
adds automatically the DSC extension to the description file
and the PS extension to the PostScript file.

11. The map background is saved.  You will be able to load it
later using the "Load background" command from the "File "
menu.  The display and the printing will be faster than in
vectorial mode.
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6.4. Adding the distribution of 2 species on the
previous map

The distributions to be added are those of two Hymenoptera
Sphecidae: Crabro peltatus and Ectemnius kriechbaumeri.  These
maps have been published in LECLERCQ & BARBIER (1993).

Here is the map you want to get:

✖✖

✖

✖

✖

✖
✖

✖

✖✖

✖✖

✖

✖

✖

✖

✖

✖
✖
✖

✖✖
✖✖

✖

✖

✖

✖
✖

✖✖

✖
✖

✖

✖

✖

✖ ✖

✖

Crabro peltatus   281 spécimens, 82 données

Ectemnius kriechbaumeri   95 spécimens, 73 données✖

(c) CFF 1.0 - 1995

steps:

1. In CFF select "Load map background" from the "File" menu.
In the list of files, select the file of the example n˚3 (if you
followed the instructions, the file's name is EXEMPL.DSC)
and validate your selection by double-clicking this name or
by pressing [Enter].

2. The map is displayed.
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3. From the "Options" menu, select "Symbols", then "Symbols
type".  Select "Circle (o) for symbol 1 and "Cross (X) for
symbol 2.

4. From the "File" menu, select "Add distribution".  From the
list of the displayed files, select "CRAPEL.DEG".  Once the
file is selected, CFF asks for a type of display for the
distribution.  Select "Ignore dates (one symbol for the whole
distribution)".  CFF asks then to specify the symbols
diameter.  The diameter must be expressed in meters.
Type 10000 as value.  The distribution of Crabro peltatus is
displayed.

5. Repeat the operation for the "ECTKRI.DEG".  Now the
distribution of Ectemnius kriechbaumeri is displayed.

6. You can print the map using the "Printing" menu.  The
colours and the symbols setgray can be controled using the
"PostScript..." command from the "Options " menu.  As
symbols setgray, select "black" for symbol 1 and "white" for
symbol 2.



CFF - User's manual - 77

6.5. Adding, to example map 2, the distribution of a
species with size-symbols proportional to the
number of specimens, a UTM grid pattern and a
text string specifying the country

France

Spain

Italy

Mediterranean sea

✖

Crabro peltatus                                                                 
Total: 281 specimens, 82 data

More than 10 specimens
6 - 10
Less than 6
presence✖

(c) CFF 1.0 - 1995

First,  follow steps one through three from example 3.

4. From the "File" menu, select "Add boundary".  Choose
"UTM100.CFF" as the file to be added.  The 100 km-side
UTM grid pattern is displayed.

5. From the "File" menu, select "Add distribution".  Select
"CRAPEL.DEG" as the distribution file.  Select then, as
distribution type, "Symbols proportional to the number of
specimens".  CFF displays a window with the maximal
number of specimens and data found in the file.  Type 3 as
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the number of classes to be distinguished.  Type then,
successively, 10, 5 and 0.  Type 10000 as the diameter of
the largest points.

6. The distribution is displayed.

7. In the "Edition" menu, select the "Add text" command.
Type "France" as text string.  Select then, in the new
window displayed, "16 pts" as the size.  CFF displays a
rectangle in the top of the map.  Move this rectangle using
the mouse and position it on France.  Click the left-hand
mouse button.

8. Repeat the precedent operation with "Spain", "Italy" and
"Mediterranean sea".

9. You can now print the map.
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7. Tricks

In this chapter, you will find information about ways to improve the
PostScript printings of your maps.  In order to achieve this, you need
a basic knowledge of DOS .  You need to know how to save files on
floppy disks, edit files and save them in an ASCII format.

The ideal thing is to have some prior knowledge about PostScript in
order to understand the content of the printing files.  PostScript is a
programmation language, as the C language or the BASIC language.
It is possible to modify the printing files, which are programs, in order
to change the final result.  You will find a list of specialized works
about PostScript in the annex.

With this basic knowledge, you will be able to modify some printing
parameters.

7.1. The PROLCFF.PS file

This file, called prologue, contains a number of procedures which will
be used when printing the map.

When printing, via a printer or a EPS file, the prologue is always the
first one to be sent, followed by the map (boundaries, distributions,
text strings).

If you modify a prologue's definition, it will be taken into account in all
later printings.  In order to modify the prologue's definition, edit the
PROLCFF.PS file using an editor or a word processor.  Don't forget to
always save it in an ASCII format.

In the prologue, all the lines beginning with the % character are
comments.  These are used to make the program easier to
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understand.  The lines beginning with %% are comments more
specifically structured; they must not be modified.

Here are some easy modification examples:

Changing the frame thickness

In the first line beginning with /ec , change .1  into 1.  The frame
thickness will be more noticeable (the unit is the point, or about 1/72
inch or 0.3 mm).

Changing the ZapfDingbats symbols

The symbols 2 to 7 are included in the ZapfDingbats font.  It is easy
to change the default characters.  These symbols are defined in the
prologue as the procedure /s2  to /s7  or /sc2  to /sc7  for the
coloured symbols.

For example, in order to get a star ❋  instead of a cross ✚, transform
the line

"/s2 {gris xd 1 SymbZapf eq {(:) zapf } {s2ai}
ifelse bd "

into

"/s2 {gris xd 1 SymbZapf eq {(k) zapf } {s2ai}
ifelse bd "

in ZapfDingbats, the ":" character corresponds to the cross
while the "k" character corresponds to the star (see table of
charaters in annex).

Modification of the lines thickness

The lines thickness is controled by the procedures: EpTresFin ,
EpFin , EpNorm, EpGras  and EpTresGras .  If, for instance, you
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think that the thickness "Extra thin" is too thin, then increase the value
in this procedure (.1  is the default value).

Changing the default font

The default character font is defined in the PolDef procedure.  If, for
instance, you prefer the AvantGarde character font, use the PolDef
procedure to replace /Helvetica with /AvantGarde-Book.

The characters font available depends on the PostScript printer or on
the interpreter program used.  Usually, the following fonts are
available:

Courier Bookman-Demi
Courier-Bold Bookman-LightItalic
Courier-Oblique Bookman-DemiItalic
Courier-BoldOblique Times-Roman

Helvetica Times-Bold

Helvetica-Bold Times-Italic

Helvetica-Oblique Times-BoldItalic
Helvetica-BoldOblique NewCenturySchlbk-Roman
AvantGarde-Book NewCenturySchlbk-Bold
AvantGarde-Demi NewCenturySchlbk-Italic
AvantGarde-BookOblique NewCenturySchlbk-
AvantGarde-DemiOblique BoldItalic
Helvetica-Narrow Palatino-Roman
Helvetica-Narrow-Bold Palatino-Bold
Helvetica-Narrow-Oblique Palatino-Italic
Helvetica-Narrow-BoldOblique Palatino-BoldItalic
Bookman-Light ZapfChancery-MediumItalic
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Changing the title's font

The default font used for the distributions titles (taxons' names) is
Times-BoldItalic .  You can change the default font in the
PolTitre procedure as explained previously.

7.2. Adding a trame in the PostScript files associated
to the saving files

The PostScript associated to the saving files can be modified in the
same way as the prologue.  But the content is complicated because it
almost always consists of geographical boundaries.

The CORSTOSC.PS file, delivered with the software, is an example
of a map re-worked with the associated PostScript file.  In this file, the
trame representing the Mediterranean Sea has been added.

In PostScript, in order to "paint" a surface, this latter must be closed.
In other words, the ending point must correspond to the starting point.
The PostScript command "closepath " is used to automatically close
a curve.

When the curve is closed, you can fill it in using the "fill "
command.  Before using this command, you need to specify a gray
value with the "setgray " instruction.  The setgray's values go from 0
(black) to 1 (white).  For example, ".9 setgray " will produce a light
gray.  In order to fill in the surface with light gray, you have to be sure
that the curve is closed and then execute ".9 setgray fill ".

But the "fill " instruction erases the boundary in memory.  In other
words, after the use of this instruction, it is no longer possible to draw
the line's curve.  In order not to loose the boundary in memory after
the use of "fill ", the instruction is inserted between both "gsave "
and "grestore " commands.  The filling and drawing procedure of a
curve becomes: "gsave .9 setgray fill grestore ".
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Here is how to add a trame to your maps:

1. Copy out, in the beginning of the saved PostScript file (a file
without prologue, saved in the reference directory), the
trame definitions contained in the CORSTOSC.PS.  The
lines are the following:

/SetFreq {currentscreen 3 -1 roll pop
setscreen} bind def

/SetAngle {currentscreen 3 1 roll pop 3 1
roll setscreen} bind def

/Trame {Lx Ly m Lx Uy l Ux Uy l Ux Ly l c
gsave 30 SetFreq 130 SetAngle .9 setgray
fill grestore 0 setgray s} bind def

Trame

2. The last line, "Trame", will fill in the frame with gray .9 at a
130˚ inclination.  The trame's inclination is useful when a
grid pattern is added to the map.  It improves the sharpness
of the grid pattern and avoids watering.

3. The frame is now completely gray, each part of the territory
will have to be filled in with white in order to be added to the
gray frame.  At this stage the operation is very delicate.
Each line segment begins with a coordinate followed by "m"
and ends with a coordinate followed by "s".  For small
islands such as Elba, you will notice that the starting
coordinate corresponds to the ending coordinate.  It is the
easier case because the curve is already closed.  In this
case, you have to add, at the end of the curve before "s",
the following line: "gsave 1 setgray fill grestore ".

In most of the cases, the curves are not closed.  For France
(FRANCE1.CFF file), the boundary consists of several
small segments.  Hopefully, the segments are placed in a
logical order (clockwise).  In this case, you need to "link" all
the segments in order to close the new curve.  Only then,
you can fill in the surface with white.

In other cases, only a part of the curve appears in the frame.
The rest is outside.  In this case, the curve must be closed
outside the frame (what is outside the frame is not printed).
According to the position of the curve in the frame, you
need to add 1,2 or 3 new points outside the frame which
will enable you to close the curve.

Finally, with some files as MFMWDB*.ALL, it is almost
impossible to close the curves because the constituent
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segments are displayed in an uncoordinated way and in
different directions.

7.3. Not wasting too much disk space with the
PostScript files

We saw that the PostScript files associated to the saved map
background allow a quick display and printing of the maps.

Each time such a file is printed, it is entirely recopied in a new target
file with the prologue and the distribution.

When you realise several maps with a same background, the number
of files generated becomes larger as well as the space occupied on
the hard disk.

The "run " PostScript instruction is used to execute an external
PostScript file.  This instruction will enable you to save much space
on the hard disk.

Concrete example:

1. rename the CORSTOSC.PS file in CORSTOSC.@PS.

2. create a new CORSTOSC.PS and write in, as sole line,
"(/banque/cartog/corstosc.@ps) run " (without the
inverted comas!)*.

As you can see, the new CORSTOSC.PS file contains the access path
to the CORSTOSC.@PS.  This configuration can work with your
computer but not necessarily with your colleague's computer.

Moreover, the "run" instruction is unreadable by a PostScript printer.
This latter can't read your hard disk.  You then need to use an
interpreter program (ex: GoScript) in order to access that instruction.

 

*Attention! In PostScript you have to use "/" (slash) instead of "\" (backslach)



CFF - User's manual - 85

This procedure, while saving hard-disk space, should only be used on
a local scale, for files which won't be exchanged with other people's
files.
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8. File formats

8.1. CFF.INI

It is an ASCII-type file.  It contains the backup copy of the options you
determine when using CFF.

Structure:

The file is commented.  A line of comment comes before the  
value of the variable in question.  For the options relative to
the boundaries (colour, ...), the order is the same as in the
CFF window (Border 1, Border 2, ..., Grid 4, Grid 5).  All
told, the file contains 179 lines.

8.2. DEG and RAD distribution files

These files contain the coordinates of the distributions as well as of
the associated parameters.  They are ASCII-type files.  You can
create an application which generates this type of files.  They will then
display on the CFF maps.  In this case, you must rigorously adhere to
the prescribed format.

Structure (see example above):

● line 1: title of the distribution;

● line 2: total number of individuals, data and UTM squares.
The format must be carefuly adhered to 14 characters for
each component;

● line 3: distinguished periods.  This line contains the  3
periods you can distinguish in this type of file.  If there are
less than 3 periods distinguished, indicate the periods you
don't use with "0 - 0";

● line 4: number of individuals, occurences and square by
distinguished period;

● line 5: not used (only a carriage return);
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● following lines: the distribution

- character 1: number of the period (1 to 3)

- character 2: not used in this version

- characters 3 to 13: latitude of the considered point with
its sign and in decimal degrees

- characters 14 to 21: longitude of the considered point
with its sign and in decimal degrees

- characters 22 to 26: number of specimens for a given
coordinate (above)

- characters 27 to 31: number of data

● last line: fin du fichier (in french, spelled out)

Example of *.DEG distribution file

ECTEMNIUS KRIECHBAUMERI
NINDTOT=000098 OCCTOT=000076 CARTOT=000000
 0000 - 1949   1950 - 1995   0 - 0
NIND1=000011 OCC1=000011 CAR1=000000 NIND2=000087 OCC2=000065
CAR2=000000

2K+45.16486  +5.73563    1    1
1K+44.44551  +5.70182    1    1
2K+44.44551  +5.70182    3    2
2K+44.26265  +5.81870    2    2
2K+44.43930  +5.95283    1    1
2K+44.90088  +6.53023    1    1
2K+44.63371  +6.66767    1    1
2K+43.90594  +5.67728    3    1
2K+44.08580  +5.68538    2    2
2K+43.99288  +5.80589    3    3
2K+44.08280  +5.81014    8    5
1K+43.98975  +5.93043    1    1
2K+43.98975  +5.93043    3    3
1K+44.08280  +6.18986    2    2
2K+44.08280  +6.18986    1    1
2K+43.72606  +6.33075    1    1
2K+44.17574  +6.31054    1    1
1K+44.44842  +6.42372    1    1
2K+44.00145  +6.56787    1    1
2K+44.09140  +6.56419    7    7
1K+44.00404  +6.69249    2    2
2K+44.00404  +6.69249    6    4
1K+44.27391  +6.68195    1    1
1K+44.36386  +6.67841    1    1
2K+43.64661  +6.83021    1    1
2K+44.09878  +6.93867    1    1
2K+43.83670  +7.44523    6    2
1K+43.36336  +5.77668    1    1
2K+43.36336  +6.22332    6    3
2K+42.40652  +2.93924    1    1
2K+42.83900  -0.98105    1    1
2K+42.74679  -0.86188    1    1
fin du fichier
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The *.RAD files have the same structure as the *.DEG files.  But the
coordinates are given in 1/10000 of radians (see below).  The
coordinates take less space in the *.DEG files.  The *.RAD files, less
accurate than the *.DEG files, are kept to insure compatibility with
Microbanque Faune-Flore (RASMONT et al, 1993).

SCELIPHRON CAEMENTARIUM
NINDTOT=000530 OCCTOT=000394 CARTOT=000000
 0000 - 1949   1950 - 1994   0 - 0
NIND1=000006 OCC1=000006 CAR1=000000 NIND2=000524 OCC2=000388
CAR2=000000

1K 8512   363    2    2
2K 7554   604    2    2
2K 7554   615    2    2
2K 7633   616    0    2
2K 7613  1165    4    4
2K 7429  1534    2    2
2K 7311  1629    2    2

fin du fichier

8.3. CFF, PRN, ALL boundaries files

8.3.1.  CFF files

For copyright reasons, the CFF files format is not delivered (see
chapter 1).

The CFF files have a binary format.  They can be read much faster
than the ASCII files and, for the same amount of information, occupy
less space on disk.

The CFF files of the EEC ("NUTS" files) are often redundant because
common borders override.  It is because each segment is a closed
curve.  For instance, for the FRANCE3.CFF file, each department
boundary exists in its totality.  Inside the country, each segment is
therefore twice repeated.

The CFFCONV.EXE utility allows to convert a PRN file (see below)
into a CFF-type file.
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8.3.2.  ALL files

The ALL files have a binary format.  Their format is the one of the
famous "Micro World DataBank" file.  These files are in the public
domain.

The MFMWDB*.ALL files derived from the MWDB*.ALL files.  They
are identical to the original except that the border of the former East
Germany has been removed as well as the air lane which covered the
former East Germany.

structure:

Each recording is composed of 3 integers (2 bytes each)

In BASIC, the structure is the following:

 TYPE Micro
        Code AS INTEGER
        Latitude AS INTEGER
        Longitude AS INTEGER
      END TYPE

Code is used to describe the node whose coordinates are the
following.  The thousand figure indicates the boundary type:
1 for coasts*, 2 for country borders, 3 for the United States,
5 for islands, 6 for lakes and 7 for rivers.

Latitude  and Longitude  are expressed in minutes,
starting from the equator for the latitudes and from the
Greenwich meridian for the longitudes.

8.3.3.  PRN files

The files are ASCII-type.  They are used by the VMAP software for
boundaries or distributions.

 

*Because this kind of border is not taken into account by CFF, coastlines borders are
controlled as if they were canals
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Structure:

The lines consist of a minimum of 3 elements which are
separated by one or more spaces.

First element: -1 or 0.  -1 specifies to the program it must begin
a new segment.  0 indicates it should keep working on the
current segment.

Second element: latitude in decimal degrees.

Third element: longitude in decimal degrees.  It must be ended
with the ":" character.

Fourth element (optional): a comment.  It must not contain
blanks, comas or mathematical operation characters.

example of a PRN file:

-1 +49.6819  +5.8153:SEMOIS
0  +49.6773  +5.8062:
0  +49.6785  +5.7970:
0  +49.6811  +5.7909:
0  +49.6839  +5.7906:
0  +49.6871  +5.7925:
0  +49.6906  +5.7916:
0  +49.6932  +5.7908:
0  +49.6943  +5.7891:

The utility CFFCONV allows to convert a PRN file into a CFF file.
This conversion has two advantages: quickness and exploitation of
the boundaries hierarchy.

8.4. Menus and messages files

8.4.1.  Menu files

The text string of the menus is included in the CFFMENU.* files (*
stands for the language: FR=French, EN=English, ES=Spanish,
DE=German, IT=Italian and NE=Dutch).
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If you want to adapt or correct this file, respect the format.  A helpful
piece of advise: before any  modification, make a backup copy of
your files!

The items are given in the order in which they appear on the screen,
going from left to right and from top to bottom.  Each line contains 2
input data separated by a coma: the text string (between both "") and
the number of the letter which will be used as short cut (the first has
the number 0).  A piece of the CFFMENU.EN is given below.

"File",0
"New map",0
"Add contour",0
"Remove contour",0
"Add distribution",4
"Remove all distributions",4
"-",0
"Load background",5
"Save current background",0
"-",0
"Save settings",11
"Load settings",0
"-",0
"Dos Command",0
"Exit              ALT+F4",1

8.4.2.  Messages files

As for the menu files, they have an extension which stands for the
language used.  Their format is nevertheless different.  These files
must have a 84 characters fixed-length + carriage return for
EACH line .

The lines are made up as follows:

1. 4 numbers which stand for the line number;

2. the message;

3. the end of the message symbolized by the character ∞
(alt+236);
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4. as many spaces as you need to reach 84 characters.  At
the end of each line, the character Ø (alt+237) has been
added which easy its marking out.

For any modification of these files, avoid writing messages whose
length is greater than the lenght of the CFFMESS.FR file (which is the
original file).



CFF - User's manual - 93

9. Trademarks

PostScript  is a registered trademark of Adobe systems inc.
GoScript  is a registered trademark of LaserGo inc.  GhostScript  is a
registered trademark of Aladdin Enterprises.  Microsoft Word  is a
registered trademark of Microsoft corporation.  PageMaker  is a
registered trademark of Aldus Coporation.  PkZip  and PkUnzip  are
registered trademarks of PKWARE, Inc.  Vmap  is copyrighted by
Charles H.  Culberson.  Times , Helvetica , Palatino  and New
Century Schoolbook  are registered trademarks of Allied
Corporation.  Bookman , ZapfChancery , ZapfDingbats  and
AvantGarde Gothic  are registered trademarks of International
Typeface Corporation.

10. Thanks

We want to thank all the people who contributed to the creation of
Carto Fauna-Flora.  They are Dr R.  Constantin (St-Lô, France), Dr F.
Javiez Ortiz Sanchez (Almería, Spain), Mr.  J.-M.  Silbert and S.
Delmas (Société entomologique du Limousin, Limoges, France), Dr.
D. Drugmand (Institut royal des Sciences Naturelles de Belgique,
Bruxelles), Mr.  M.  Terzo (Université de Mons-Hainaut, Belgique)
and Mr.  Fabrice Etienne (Hastière, Belgique).  We also thank Benoît
Bouchez (student at the "Ecole des Interprètes Internationaux de
Mons") for the english translation.
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 Fichiers de contours
Contour Files

BELG1.CFF + LUXEMB1.CFF

(c) CFF 1.0 - 1995

BELG2.CFF

(c) CFF 1.0 - 1995
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BELG3.CFF

(c) CFF 1.0 - 1995

BELG4.CFF

(c) CFF 1.0 - 1995
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BELGRIV.CFF

(c) CFF 1.0 - 1995

FRANCE1.CFF + CORSE1.CFF

(c) CFF 1.0 - 1995
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FRANCE3.CFF + CHANNEL.CFF

(c) CFF 1.0 - 1995

FRANRIV.CFF

(c) CFF 1.0 - 1995
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ESPA1.CFF + BALEAR1.CFF

(c) CFF 1.0 - 1995

ESPA3.CFF

(c) CFF 1.0 - 1995
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CANARI1.CFF

(c) CFF 1.0 - 1995

ANDORRA1.CFF

(c) CFF 1.0 - 1995

PORTUGA1.CFF PORTUGA3.CFF

(c) CFF 1.0 - 1995 (c) CFF 1.0 - 1995
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MADEIR1.CFF ACORES1.CFF

(c) CFF 1.0 - 1995

(c) CFF 1.0 - 1995

MALTA1.CFF

(c) CFF 1.0 - 1995
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ITALIA1.CFF

(c) CFF 1.0 - 1995

ITALIA4.CFF

(c) CFF 1.0 - 1995
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NEDERLA1.CFF

(c) CFF 1.0 - 1995

NEDERLA3.CFF

(c) CFF 1.0 - 1995
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UK1.CFF

(c) CFF 1.0 - 1995
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UK3.CFF

(c) CFF 1.0 - 1995
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EIRE1.CFF

(c) CFF 1.0 - 1995

EIRE3.CFF

(c) CFF 1.0 - 1995
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DENMARK1.CFF

(c) CFF 1.0 - 1995

DENMARK3.CFF

(c) CFF 1.0 - 1995
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DEUTSCH1.CFF

(c) CFF 1.0 - 1995
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DEUTSCH2.CFF

(c) CFF 1.0 - 1995
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DEUTSCH4.CFF

(c) CFF 1.0 - 1995
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HELLAS1.CFF

(c) CFF 1.0 - 1995

HELLAS3.CFF

(c) CFF 1.0 - 1995
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NORWAY1.CFF + SWEDEN1.CFF + FINLAND1.CFF

(c) CFF 1.0 - 1995
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AUSTRIA1.CFF

(c) CFF 1.0 - 1995

CH1.CFF

(c) CFF 1.0 - 1995
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EXYOUGO1.CFF

(c) CFF 1.0 - 1995

HUNGARY1.CFF

(c) CFF 1.0 - 1995
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TCHEQU1.CFF

(c) CFF 1.0 - 1995

SLOVAK1.CFF

(c) CFF 1.0 - 1995
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POLSKA1.CFF

(c) CFF 1.0 - 1995

BULGARI1.CFF

(c) CFF 1.0 - 1995
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ROMANIA1.CFF

(c) CFF 1.0 - 1995

ALBANI1.CFF

(c) CFF 1.0 - 1995
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ICELAND1.CFF

(c) CFF 1.0 - 1995

TURKWEST.CFF

(c) CFF 1.0 - 1995
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MAROC1.CFF + ALGERIE1.CFF + TUNIS1.CFF (partim)

(c) CFF 1.0 - 1995
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NUTSREST.CFF

(c) CFF 1.0 - 1995
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MFMWDB2.ALL (projection: Gall)

(c) CFF 1.0 - 1995
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 Fonds de carte
Background maps

EUROCC.DSC

(c) CFF 1.0 - 1995

MEDITER.DSC

(c) CFF 1.0 - 1995
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GAULE.DSC

(c) CFF 1.0 - 1995
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CORSALTI.DSC

(c) CFF 1.0 - 1995
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CORSTOSC.DSC

(c) CFF 1.0 - 1995

MIDI.DSC

Mer Méditerranée

(c) CFF 1.0 - 1995
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BELGIQUE.DSC

(c) CFF 1.0 - 1995

BELALTI.DSC

(c) CFF 1.0 - 1995
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TURKEY.DSC

(c) CFF 1.0 - 1995
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Table des caractères ZapfDingbats
ZapfDingbats characters chart
 33  ✁  70  ✦ 107  ❋ 177  ⑥ 214  ↔ 251  ➻
 34  ✂  71  ✧ 108  ● 178  ⑦ 215  ↕ 252  ➼
 35  ✃  72  ★ 109  ❍ 179  ⑧ 216  ➘ 253  ➽
 36  ✄  73  ✩ 110  ■ 180  ⑨ 217  ➙ 254  
 37  ☎  74  ✪ 111  ❏ 181  ⑩ 218  ➚
 38  ✆  75  ✫ 112  ❐ 182  ❶ 219  ➛
 39  ✇  76  ✬ 113  ❑ 183  ❷ 220  ➜
 40  ✈  77  ✭ 114  ❒ 184  ❸ 221  ➝
 41  ✉  78  ✮ 115  ▲ 185  ❹ 222  ➞
 42  ☛  79  ✯ 116  ▼ 186  ❺ 223  ➟
 43  ☞  80  ✰ 117  ◆ 187  ❻ 224  ➠
 44  ✌  81  ✱ 118  ❖ 188  ❼ 225  ➡
 45  ✍  82  ✲ 119  ◗ 189  ❽ 226  ➢
 46  ✎  83  ✳ 120  ❘ 190  ❾ 227  ➣
 47  ✏  84  ✴ 121  ❙ 191  ❿ 228  ➤
 48  ✐  85  ✵ 122  ❚ 192  ➀ 229  ➥
 49  ✑  86  ✶ 123  ❛ 193  ➁ 230  ➦
 50  ✒  87  ✷ 124  ❜ 194  ➂ 231  ➧
 51  ✓  88  ✸ 125  ❝ 195  ➃ 232  ➨
 52  ✔  89  ✹ 126  ❞ 196  ✍ 233  ➩
 53  ✕  90  ✺ 127  197  ➅ 234  ➪
 54  ✖  91  ✻ 161  ❡ 198  ➆ 235  ➫
 55  ✗  92  ✼ 162  ❢ 199  ➇ 236  ➬
 56  ✘  93  ✽ 163  ❣ 200  ➈ 237  ➭
 57  ✙  94  ✾ 164  ❤ 201  ➉ 238  ➮
 58  ✚  95   165  ❥ 202  ➊ 239  ➯
 59  ✛  96  ❀ 166  ❦ 203  ➋ 240  
 60  ✜  97  ❁ 167  ❧ 204  ➌ 241  ➱
 61  ✝  98  ❂ 168  ♣ 205  ➍ 242  ➲
 62  ✞  99  ❃ 169  ♦ 206  ➎ 243  ➳
 63  ✟ 100  ❄ 170  ♥ 207  ➏ 244  ➴
 64  ✠ 101  ❅ 171  ♠ 208  ➐ 245  ➵
 65  ✡ 102  ❆ 172  ① 209  ➑ 246  ➶
 66  ✢ 103  ❇ 173  ② 210  ➒ 247  ➷
 67  ✣ 104  ❈ 174  ③ 211  ➓ 248  ➸
 68  ✤ 105  ❉ 175  ④ 212  ➔ 249  ➹
 69  ✥ 106  ❊ 176  ⑤ 213  → 250  ➺
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